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Notice

This Inter-Tel Attendant Console User Guide is released by INTER-TEL, INC. as a guide
for system users and trainers. It provides information necessary to properly install,
program, operate, and maintain the system.

The contents of this guide reflect current INTER-TEL standards and are subject to revision
or change without notice. Software packages released after the publication of this guide will
be documented in addenda to the guide or succeeding issues of the guide.

If additional information is required, please contact your service representative.

If you have any questions or comments regarding this manual or 
other technical documentation, contact 

Inter-Tel�s Technical Publications Department at: 
Tech_Pubs@inter-tel.com

Inter-Tel® is a registered trademark of Inter-Tel, Incorporated.
Microsoft® Windows® and MS-DOS are registered trademarks of Microsoft Corporation.
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QUICK REFERENCE GUIDE TO
FREQUENTLY USED FEATURES

These are the basic instructions for the most frequently used telephone system
and voice mail features. For detailed information on these and other features,
refer to the complete instructions in the User Guide.

TO PLACE A CALL
� Type the number in the Number or Name box in the Directory and press

ENTER. (You do not need to enter an outgoing access code for outside
calls.)

TO ANSWER A CALL
� Select the Answer icon OR press F9.

TO HANG UP
� Press F12 OR select the Hang-Up icon.

TO PLACE A CALL ON HOLD
� Press F10 OR select the Hold icon.
� Press Answer to remove the call from Hold.

TO PLACE A CALL ON SYSTEM HOLD
� Select the Sys Hold icon.

TO TRANSFER A CALL
� Select the destination number in the directory.
� Press ENTER to transfer the call to the number.

TO TRANSFER TO VOICE MAIL
� Select the destination number in the directory.
� Select Voice Mail in the directory or press CTRL+ENTER.

TO CANCEL A TRANSFER
� You can cancel a transfer at any time before the transfer is completed. Select

the Cancel Trn icon OR press F6.

TO MAKE A PAGE
� Highlight the desired page zone in the Page Zones dialog and press ENTER

OR select Begin Page
OR double-click on the desired page zone. 

� Make your announcement before the Paging timer expires, then hang up.
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MESSAGES
TO LEAVE A MESSAGE AT THE STATION
� Press CTRL+E OR select the Mess. Call icon.

TO LEAVE A VOICE MAIL MESSAGE
� Press CTRL+O OR select the Leave VM icon.

TO LEAVE A SILENT MESSAGE (WITHOUT PLACING A CALL)
� Select an entry in the Directory, and then select Message on the Directory.

TO REMOVE A MESSAGE WITHOUT RESPONDING
� From the Messages dialog (displayed through the Tools drop-down menu),

highlight the message and select Remove.
To remove all the messages in the list, Select Remove All.

TO RESPOND TO A MESSAGE
If you have waiting messages, the message indicator on the status bar says MSG
and a small lamp symbol appears. Each message is identified with the source of
the message, time and date stamp, and the number of the messages from the
messaging station.

NOTE: If a station-to-station message is left more than once between the same
two extension numbers, the message count will only display �1.�

� Highlight the message and click Reply OR double-click on the message.
If the called station is unavailable (does not answer the call, is busy, or is in
do-not-disturb), the message remains in the list and you can try again later
or leave your own message for that station.

NIGHT MODE
TO PLACE YOUR SYSTEM IN NIGHT MODE
� Select Night Mode from the Console drop-down menu and select On.

Whenever the system is in night mode, the Status bar displays NGT.

NOTE: This procedure places only your system in night mode. In a multi-node
network, if you will be placing other nodes into night mode, you may want to pro-
gram a shortcut key to enable and disable Network Night Mode. For more details,
refer to the Attendant Console User Guide.
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CONFERENCE CALLS
TO BUILD A CONFERENCE
You can build a conference from calls that are either connected or on individual
hold in the main Call List. You cannot add ringing calls.

� Highlight the desired call from the call list. 
� Press CTRL+N (this option is available only while you are on a call)

OR CTRL+R
OR select Conference
OR drag and drop the highlighted call onto the Conference Setup dialog.
The Console copies the call into the Conference Setup list.

� Repeat for all calls to be included in the conference. There is no active con-
ference yet, you still must connect the conference, as described below.
If you copy the wrong call into the Conference tag list, remove it by high-
lighting it in the Conference Setup list and selecting Remove Call. This
does not affect the Call List, only the Conference Setup list. 

TO CONNECT A CONFERENCE
When you have built your Conference list, you are ready to connect the confer-
ence call.

� Select Begin on the Conference dialog. 
� At any time during the conference, you can add another call into the confer-

ence. 

VOLUME AND MICROPHONE MUTE
TO ADJUST THE VOLUME
� Select Up or Down from the Volume drop-down menu

OR press CTRL+P to increase the volume or CTRL+W to lower the vol-
ume.
To save your volume settings, Select Save from the Volume drop-down
menu.

TO MUTE THE MICROPHONE
� Press CTRL+U OR Select Mute from the Volume drop-down menu. (To

unmute the microphone, select Mute again.)
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Limited Warranty
Inter-Tel Atten
Inter-Tel, Inc. warrants the physical diskette(s) and physical documentation enclosed
herein (but not any diskettes or documentation distributed by you) to be free of
defects in materials and workmanship for a period of sixty days from the purchase
date. If Inter-Tel Integrated Systems receives notification within the warranty period
of defects in materials or workmanship, and such notification is determined by Inter-
Tel Integrated Systems to be correct, Inter-Tel Integrated Systems will replace the
defective diskette(s) or documentation. DO NOT RETURN ANY PRODUCT UNTIL
YOU HAVE CONTACTED YOUR DEALER. YOUR DEALER WILL BE
RESPONSIBLE FOR OBTAINING RETURN AUTHORIZATION.
The entire and exclusive liability and remedy for breach of this Limited Warranty
shall be limited to replacement of defective diskette(s) or documentation and shall not
include or extend to any claim for or right to recover any other damages, including
but not limited to, loss of profit, data, or use of the software, or special, incidental, or
consequential damages or other similar claims, even if Inter-Tel Integrated Systems
has been specifically advised of the possibility of such damages. In no event will
Inter-Tel Integrated System's liability for any damages to you or any other person ever
exceed the lower of suggested list price or actual price paid for the license to use the
software, regardless of any form of the claim.
THIS WARRANTY IS IN LIEU OF AND EXCLUDES ALL OTHER WARRAN-
TIES, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, ANY
IMPLIED WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTIC-
ULAR PURPOSE. THERE ARE NO WARRANTIES WHICH EXTEND BEYOND
THIS LIMITED WARRANTY. Specifically, Inter-Tel Integrated Systems makes no
representation or warranty that software is fit for any particular purpose and any
implied warranty of merchantability is limited to the sixty-day duration of the Limited
Warranty covering the physical diskette(s) and documentation only (and not the soft-
ware) and is otherwise expressly and specifically disclaimed.
This Limited Warranty does not apply to any products damaged by improper han-
dling, normal wear and tear, accidents, lightning damage, negligence, or improper use
or maintenance and does not apply to products altered without authorization by Inter-
Tel Integrated Systems.
This Limited Warranty gives you specific legal rights; you may have others which
vary from state to state. Some states do not allow the exclusion of incidental or conse-
quential damages, or the limitation on how long an implied warranty lasts, so some of
the above may not apply to you.
vdant Console User Guide



Software License Agreement
vi
THE FOLLOWING IS A LICENSE AGREEMENT RELATING TO THE INTER-
TEL SOFTWARE. PLEASE CAREFULLY READ ALL OF THE TERMS AND
CONDITIONS BEFORE PROCEEDING. THE SOFTWARE REFERENCED
HEREIN IS LICENSED IN ACCORDANCE WITH THE FOLLOWING TERMS
AND CONDITIONS. IF YOU DO NOT ACCEPT SUCH TERMS AND CONDI-
TIONS YOU WILL NOT BE PERMITTED TO USE THE SOFTWARE. IF YOU
ACCESS OR USE SUCH SOFTWARE IN CONTRAVENTION OF THE TERMS
AND PROVISIONS OF THIS AGREEMENT, YOU WILL BE SUBJECT TO
PROSECUTION TO THE FULLEST EXTENT PERMITTED BY LAW.

Definitions:

�You� means, and �Yours� refers to the original end user purchaser of the Inter-Tel
Software Programs. �Computer� means a computer consisting of a single central pro-
cessing unit, one keyboard and one video display terminal. �Inter-Tel Hardware Sys-
tem� means any proprietary system distributed by Inter-Tel Integrated Systems
(hereinafter �Company� or �Inter-Tel�) that operates by means of the Software.
�Authorized Dealer� means an individual or entity currently authorized in writing by
agreement and in good standing with Inter-Tel entitling the dealer to sell or license the
specific Software covered by this license. �Software� means: the computer programs
accompanying this License (including, but not limited to, codes, techniques, software
tools, formats, designs, methods, processes, know-how and ideas) and any and all
copies, modifications, upgrades, enhancements and new releases thereof made or
acquired by You and any and all manuals and other printed materials accompanying
this License or the Software

License:

(a) Inter-Tel Integrated Systems, Inc. (�Inter-Tel�) grants You a non-exclusive,
non-transferable license to install and use the enclosed Inter-Tel Software and
accompanying documentation on any one standalone personal computer or
Inter-Tel Hardware System (whichever applies). You assume the entire respon-
sibility for the selection and installation of the enclosed Software program(s)
in order to achieve desired results. You agree that you are licensing the Pro-
gram for its end use only and not for resale or redistribution. You must be an
Authorized Dealer of the specific Inter-Tel products covered by this license.
You will be liable for theft and infringement under applicable patent, copyright
and trademark laws of the United States for unauthorized use of the Software
covered by this license.

Inter-Tel reserves all rights in and to all patents, copyrights, trademarks, mask
works and any other proprietary rights contained or embodied in the Software.
Inter-Tel Attendant Console User Guide



Inter-Tel Atten
(b) You may make one (1) copy of the Inter-Tel Software program(s) contained on
diskette(s) for back-up purposes only, provided that You reproduce and place
the Inter-Tel copyright notice on the backup copy. You may make one (1) copy
of the Software program(s) onto one (1) hard drive. You may not copy the
Inter-Tel Software program(s) contained on any media other than diskette; e.g.,
hard disk drive, ROMs, PALs, Software Protection Key, etc. 

(c) You are hereby notified that contained third-party suppliers and vendors are
third-party beneficiaries to this Agreement to the extent that the Software con-
tains software, programming and other materials provided by such third-party
suppliers and vendors. Such provisions are made expressly for the benefit of
and are enforceable by such third-party suppliers and vendors in addition to
Inter-Tel.

Non-Permitted Uses:

(a) You may not use the enclosed program(s) on more than one standalone per-
sonal computer or Inter-Tel Hardware System at a time and may not load the
Software onto any file server or network. 

(b) You may not sublicense, assign or transfer Your rights under the Agreement
without the prior written permission of Inter-Tel.

(c) You may not use, copy, alter or transfer, electronically or otherwise, the Inter-
Tel Software (program(s) or documentation) except as expressly allowed in
this Agreement.

(d) You may not translate, reverse engineer, disassemble or decompile the Inter-
Tel Software.

(e) You agree that you are licensing the Program for its end use only and not for
resale or redistribution.

Term:

This Agreement is effective from Your date of purchase and shall remain in force
until terminated. You may terminate the Agreement by returning to Inter-Tel the origi-
nal diskette(s), ROMs, PALs, or other applicable software media and all copies of the
Inter-Tel software program(s). The Agreement is also terminated if You fail to comply
with any term or condition of this Agreement. You agree to return to Inter-Tel the
original diskette(s) and other applicable software media and all copies of the Inter-Tel
Software program(s) upon such termination. The Company may immediately termi-
nate this license upon notice to you, whereupon you shall immediately destroy all
copies of the Program.
viidant Console User Guide



viii
Warranty:

(a) Inter-Tel warrants to You that the diskette(s), and/or other applicable software
media on which the Inter-Tel Software program(s) are furnished are not defec-
tive under normal use for a period of ninety (90) days from the date of pur-
chase, as evidenced by a copy of Your sales receipt.

(b) Inter-Tel and its third-party suppliers and vendors' liability and Your exclusive
remedy shall be the replacement of any diskette(s) and/or other applicable soft-
ware media that do not meet the warranty and which are returned to Inter-Tel
or an authorized dealer together with a copy of Your paid receipt. THE
ABOVE IS THE ONLY WARRANTY OF ANY KIND. ALL OTHER WAR-
RANTIES EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIM-
ITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR USE ARE HEREBY DISCLAIMED. This
warranty gives You specific legal rights and You may also have other rights
which may vary from state to state.

You acknowledge that the Program, including the related documentation and any new
releases, modifications and enhancements thereto, belongs to the Company, and that
the Company retains all right, title and interest in and to the Program. You further
acknowledge that the Program and information relating thereto constitute valuable
trade secrets of the Company. You agree to comply with the terms and conditions of
this Agreement and agree to treat the Program as the confidential and proprietary
information of the Company.

You shall be solely responsible for the supervision, management and control of your
use of the Program and related products and documentation. You hereby indemnify
and hold harmless the Company and its affiliates (the Indemnified Parties) against any
loss, liability, damages, costs or expenses suffered or incurred by the Indemnified Par-
ties at any time as a result, of any claim, action or proceeding arising out of or relating
to your use, operation or implementation of the Program. For purposes of this Agree-
ment, affiliate means any Company division or subsidiary or any other affiliated
entity involved in the manufacture or wholesale distribution of Company products.

The Indemnified Parties shall not be responsible, and you shall have no recourse
against the Indemnified Parties, for any loss, liability, damages, costs or expenses
which may be suffered or incurred at any time by you as a result of your reliance upon
or use of the Program, or as a result of any claim, action or proceeding against you
arising out of or relating to the use of the Program, or as a result of your defense of
any such claim, action or proceeding.
Inter-Tel Attendant Console User Guide
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Limits Of Liability:

In no event shall Inter-Tel or its third-party suppliers and vendors be liable for any
losses (whether in tort, contract or otherwise) incurred in connection with the pur-
chase, sale, possession, operation, or use of the Software (separately or in combina-
tion with other products) including, but not limited to loss of time, loss of anticipated
profits, loss of data, loss of information, loss of business, loss of revenue, loss of
goodwill or loss of anticipated savings or other business losses, losses relating to rout-
ing or programming errors, unauthorized use or access of all intrastate, interstate, and
international long distance services, or such access or use by voice mail, DISA, auto
attendant, or 800 or 900 services by end-users or unrelated third parties, losses related
to the use of copyrighted music with Inter-Tel Software, and to the extent such limita-
tion is permitted by applicable law, losses and damages resulting from physical injury
to tangible property or death or injury of any person whether arising from Inter-Tel's
negligence, breach of contract or otherwise. IN NO EVENT SHALL INTER-TEL OR
ITS THIRD-PARTY SUPPLIERS AND VENDORS BE LIABLE FOR ANY INCI-
DENTAL OR CONSEQUENTIAL DAMAGES, DIRECTLY OR INDIRECTLY
ARISING FROM USE OR INABILITY TO USE THE SOFTWARE, SEPARATELY
OR IN COMBINATION WITH OTHER PRODUCTS. IN NO EVENT SHALL THE
TOTAL LIABILITY OF INTER-TEL DAMAGES EXCEED THE AMOUNT PAID
BY YOU FOR THE SOFTWARE.

Entire Agreement:

This Agreement constitutes the entire agreement between You and Inter-Tel and
supersedes any and all prior agreements between Inter-Tel and You with regard to the
Inter-Tel Software. No amendment, modification or waiver of this Agreement will be
valid unless set forth in a written instrument signed by the party to be bound thereby.
This Agreement shall be governed by the laws of the State of Arizona. No failure or
delay on the part of Inter-Tel to enforce its rights hereunder shall operate as a waiver
of any right.

This Agreement and any disputes arising hereunder shall be governed by the laws of
the State of Arizona, United States of America, without regard to conflicts of laws
principles. The parties hereby expressly exclude the application of the U.N. Conven-
tion on Contracts for the International Sale of Goods to the Agreement.

Government Restricted Rights:

The Software is provided with restricted rights. Use, duplication or disclosure by the
government is subjected to restrictions set forth in subparagraph c (1) (ii) of the
Rights in Technical Data and Computer Software clause at DFARS 252.227-7013
(Oct. 1988) and FAR 52.227-14 and 52.227-19 (June 1987). Contractor is Inter-Tel
Integrated Systems, Inc., Chandler, Arizona 85226.
ixdant Console User Guide
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Thank you for purchasing Inter-Tel�s Attendant Console version 3.0 software pack-
age. The Attendant Console streamlines system attendant operations by linking the
call processing capability of your Inter-Tel telephone system with your personal com-
puter (PC).
The Attendant Console software is loaded on your PC and runs on Microsoft Win-
dows 98, Windows 2000, Windows Millennium Edition, Windows NT 4.0 with Ser-
vice Pack 3 or higher, and Windows XP.
ABOUT THIS USER�S GUIDE
This user guide provides all of the information you will need to use the Attendant

Console and its features.
 • Getting Started includes installation instructions that tells how to set up your

Attendant Console.
 • Using the Attendant Console includes basic call handling instructions and other

information you need to know to start using Attendant Console features.
 • Troubleshooting covers error handling, troubleshooting procedures and fre-

quently asked questions.
THE MAJOR ENHANCEMENTS IN THE VERSION 3.0 
RELEASE

 • Extended Information in the Directory List (see page 44) � Provides addi-

tional information for stations and hunt groups in a ToolTip popup screen.

 • Directory Properties (see page 51) � Allow you to change the properties of a
directory entry.

 • Support for Axel AX4010 Office Server (see page 4) � Can be used as a Sys-
tem OAI (Open Architecture Interface) Server. The Axel Server allows up to four
RS232 Serial Ports to communicate over a LAN (Local Area Network) using IP
(Internet Protocol). For more details, refer to the Axel AX4010 Office Server
Installation Manual, part no. 935.3913.

 • Directory Index Buttons (see page 67) � Allow you to search the directory
using the number or alphabet index buttons.

 • Configuration Wizard (see page 39) � Displays the most suitable settings for
your Console to simplify programming various Attendant Console configuration
options.

 • Automatic System OAI Server Discovery (see pages 22) � Automatically
finds OAI Servers on your LAN. 
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 • Customized Toolbar � Allows you to choose toolbar buttons that are to be dis-
played on the Toolbar (see page 64).

 • Import/Export User Setting � Simplifies programming configuration by
importing/exporting existing user settings (see pages 35 and 37).
RELATED DOCUMENTATION
In addition to this user�s guide, you should become familiar with the user�s guide for

your phone. 
If you are a System Administrator, you should also obtain a copy of the telephone sys-
tem Administrator�s Guide for instructions on using the special Administrator fea-
tures.
PART NUMBERS
The Attendant Console is available in the following packages:
NOTE: The software is provided on the CD-ROM (827.9272). 

PACKAGE PART NUMBER

Multi-Node Attendant Console V3.0 550.5310
Upgrade Multi-Node Attendant Console V3.0 550.5311

� Security Key Console Multi-Node
� CD-ROM
� Attendant Console Software
� Attendant Console V3.0 User Guide
� Key Caps Label

827.9103
827.9272
827.9533
835.2270
809.2018

Single Node Attendant Console V3.0 550.5312
Upgrade Single Node Attendant Console V3.0 550.5313

� Security Key Console Single-Node
� CD-ROM
� Attendant Console Software
� Attendant Console V3.0 User Guide
� Key Caps Label

827.9129
827.9272
827.9533
835.2270
809.2018
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This chapter contains instructions for installing and setting up your Attendant Con-
sole. 
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Software Requirements
4

 • Microsoft Windows 98/2000/NT4.0/ME/XP Operating System
 • TCP/IP protocol installed on your PC
Hardware Requirements

 • Digital Phone, AgentSet, IP PhonePlus, or IP SoftPhone
 • PC-compatible computer with a 100 MHz Pentium or higher processor (200 MHz

or higher is recommended)
 • 24 MB of RAM, with a minimum of 25 MB available hard disk space (32 MB is

recommended)
 • CD-ROM drive for installation from CD
 • A monitor with 800 x 600 resolution or higher (1024 x 768 recommended)
 • Keyboard and two-button mouse
 • Parallel port or USB port (for the software security key)
 • A headset (recommended, but not required)
Telephone System and Network

 • The Inter-Tel telephone system must be using version 5.1 or higher software on

all nodes (5.119 or higher recommended).
 • Must have a TCP/IP connection to a System OAI Server (CT Gateway, Call Pro-

cessing Server - previously called Windows NT-Based CPU, System OAI Switch
Transceiver, or Axel Office Server).

 • System OAI Events and System OAI Third Party Call Control Premium Features
must be enabled on all nodes.

 • Headset mode must be enabled at your phone if using a headset (not a require-
ment).

 • In Station Programming, your phone should have the Headset Connect Tone
option enabled.

 • If the network has multiple Voice Processing Units, they must have remote mail-
boxes on the system where the Attendant Console is located to allow the Atten-
dant Console user to leave voice mail messages for all mailboxes through the
mailbox associated with the Attendant Console�s extension.
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Attendant Console
 • The outgoing feature codes must be identical on all nodes if you will be using

remote call forward programming across nodes.

Attendant Console Database Programming
 • The station database programming password must be identical on all nodes if you

will be using the Attendant Console�s database programming feature.
 • Each node has its own list of Do-Not-Disturb (DND) or Reminder messages that

can be used only on that node. Programming DND or Reminder messages in the
Console Database Programming overrides any existing messages in a network.

 • In order to use the Database Programming feature, you must be a System Admin-
istrator.

Refer to the telephone system Installation and Field Maintenance Manual for more
information on the Telephone System features.
ED
CT Gateway

The Attendant Console provides call handling for either a single telephone system or
multi-node system network. In order to support a multi-node system network, the
Attendant Console must have a TCP/IP connection to a CT Gateway that supports a
multi-node network. 
The CT Gateway coordinates events and commands from all connected sources,
allowing you to access and control devices on multiple system systems. 
Refer to the telephone system Installation and Field Maintenance Manual for more
information on the CT Gateway.
TCP/IP Connections

TCP/IP provides diagnostic and connectivity tools for connecting to other systems
and to a network. For TCP/IP to work on your computer, it must be configured with
IP addresses, subnet masks, and a default gateway for each network adapter on the
computer. To determine if TCP/IP is installed on your computer, check with your Net-
work Administrator.
Software Security Key

The software �key� is a small security device that must be attached to your PC�s par-
allel port or USB port to fully enable the Attendant Console software. Without the
key, the software will only work in �demo� mode. The software key does not affect
the functionality of the parallel port itself. Any device that you would normally con-
nect to the parallel port can also be connected through the software key.
To install the software key, simply shut down Windows, turn off the power switch on
your PC, and attach the appropriate end of the device to the parallel port or USB port
on the back of your PC.
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INSTALLING THE ATTENDANT CONSOLE SOFTWARE
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The Attendant Console software is supplied on CD-ROM. The instructions assume
that a Microsoft Windows-based operating system is installed on your PC and that
you are familiar with basic Windows navigation and using the mouse. Before installa-
tion, ensure that the Windows operating system is running and that all Windows
applications and any previous versions of the Attendant Console are closed.
The software security key must be attached to the parallel port or USB port on your
PC for you to use the Attendant Console software. Without the key, the software will
remain in demonstration mode. The key does not affect the functionality of the paral-
lel port. Any device that connects to the parallel port can be connected through the
software key.
 1. Shut down Windows and turn off the power switch on your CPU.
 2. Attach the appropriate end of the software key to the parallel port on the back of

your PC.

NOTE: You may use the same installation CD for more than one PC. However,
each PC must have its own software security key. 

 3. Restart the computer.
 4. Insert the Attendant Console CD-ROM into the drive.
 5. From the Windows Start menu, select Run.
 6. Use the Browse button to locate the Attendant Console directory on the CD-

ROM and select setup.exe. Then click OK. A license agreement dialog appears.

NOTE: During the installation, pressing ESC or Cancel will exit the setup pro-
gram without completing the installation.

 7. After reading the license agreement, click YES to begin the installation. 
 8. A Welcome screen appears, click Next to continue.
 9. A dialog box appears that asks for the desired destination directory name. Enter

<Drive>:\Program Files\Attendant Console, if it is not displayed, or
the directory where the Attendant Console files will be stored on the selected
drive. Click Next to continue (or Cancel to exit without performing the installa-
tion). 

10. Follow the directions outlined by the installation wizard, clicking Next to
advance to the next screen. You can either chose to have the Console automati-
cally configure the settings or program the following information manually.
 • IP Address: Enter the IP address of your System OAI Server.
 • TCP Port: Enter the port number of the System OAI Server.
 • OAI Password: Enter the password required by the System OAI Server.
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 • Extension: Enter your extension number.
 • Enter Station Password: Enter the station password programmed for your

station. (At default, this is your extension number.)
 • Toll Length: If the dialed number exceeds this length, the toll digits are

dialed. The default toll length is 10. For example, if the toll length is set to
10 and the toll digit is set to 1, and the user dials a ten-digit number
(6029619000), then the Attendant Console automatically appends the toll
digit(s) to the dialed number (16029619000). 

 • Toll Digit(s): These are the digits required to make a toll call. In the U.S.,
this is usually a �1.� 

NOTE: Areas that use 10-digit dialing for local calls should leave the Toll
Digit(s) field blank.

11. Click Next. The software installation will continue loading files.
12. After all files have been installed, the Attendant Console will display a window

asking if you want to add a shortcut for the Attendant Console to the Windows
Start Menu or the desktop and if you want to launch the Attendant Console on
start-up. Answer as desired.

13. Click Finish to complete the installation.
14. Restart the computer if prompted.

NOTE: If the Console is installed on Windows NT or 2000 and requires a reboot,
you must reboot the computer into an administrative account. In other words, to
install the console you must have local administrative rights.
Upgrading the Attendant Console Software

To upgrade existing Attendant Console software to a newer version:
� Simply install the newer version software into the existing Attendant Console

directory on your PC.
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STARTING THE ATTENDANT CONSOLE APPLICATION
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To start the Attendant Console, do the following:
 1. Ensure your PC is turned on and running the Windows operating system.
 2. From the Windows Start menu, select Programs, then select Inter-Tel Atten-

dant Console. The log on dialog box displays.
Logging On

You must log on to the Attendant Console before use. If you do not have previously
saved settings you can create a new user or log on as Default. The default user has the
default features and settings.
IF YOU ARE A NEW USER:

� Click Add User. This allows you to set and save your own custom features and
settings for use during another session. The following dialog appears. 

Type your name in the Enter username field and select a username that you
would like to inherit the user settings from, then click OK. For information on
setting the Attendant Console properties, see �Setting Attendant Console Proper-
ties� on page 11. 

TO USE PREVIOUSLY SET FEATURES:

� Select the desired name from the drop-down list of previously entered names,
then click Log On. The system displays the message, �Retrieving System Infor-
mation.� 

If this is the first time you have used the Attendant Console, the system will perform a
refresh.
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NOTE: If a second user logs on, the program automatically logs off the previous user.

TO LOG ON AS A DIFFERENT USER: 

 1. Select a different user from the list.
 2. Click Log On or Add User from the Attendant Console dialog box.

NOTE: If the Attendant Console does not start immediately, click Options and
check the settings under the Connection Tab. For further information, see page 113
or the Troubleshooting chapter.

TO REMOVE A USER FROM THE LIST OF NAMES:

� Select the desired username from the drop-down list box, then click Delete
User.
A
R
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Logging Off
D
TO LOG OFF THE CONSOLE:

� Select Log Off from the Console drop-down menu (see page 34 for information
on drop-down menus).
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PERFORMING A SYSTEM REFRESH
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The Attendant Console receives data from the telephone system for page zones, direc-
tory entries, and feature codes. While the Attendant Console is running, it is able to
recognize changes in the database and update its own database. However, when the
Attendant Console is not running, changes may be made to the telephone system in
which case the Console database and telephone system may be out of sync. A system
refresh must be performed in order to sync the Console database with the telephone
system.
A system refresh is performed when the Attendant Console is first installed. You have
the option of having the system perform a refresh on start-up. To do so, check Auto-
matically logon to the Console as: and select the desired login name, then
check Perform Refresh at Startup in the Program Tab under Options (see
page 16). Otherwise, you will have to do a manual refresh. 
You should perform system refreshes periodically to ensure that the latest system
information is updated in your Attendant Console.

NOTE: If the Console is running when changes are made in the Database Program-
ming, the information is automatically updated and a refresh is not required. Perform a
manual refresh only in do-not-disturb or night mode, as the Attendant Console does not
remain functional. Do not perform a refresh during peak hours, as it may slow down the
telephone system.

� Select System Refresh from the Attendant Console drop-down menu. The
Attendant Console displays a box that asks if you wish to continue. 

� Click Yes to complete the refresh (or No to cancel the refresh).
OR
You can also do a system refresh on startup by selecting Perform System
Refresh on the logon dialog (only when automatic logon is not enabled).

NOTE: If you receive the �Resync Failed� error message, the telephone system
was unable to process the resync request. The telephone system will be able to
process the request within a few minutes and then the resync will be allowed. You
can allow the Attendant Console to try again automatically or exit the Attendant
Console and try again later. Also when the Console is connected to a System OAI
Server, if the OAI Server connection fails during a system refresh, the console will
restart the refresh when the connection is restored.
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Inter-Tel Atten
To set the Console properties, select Options from the Console drop-down menu
(see page 34, for information on drop-down menus) or from the initial start-up win-
dow. The Options window includes options for User, Transfer, Program, Locations,
Night Mode, Connection, Warnings, and Diagnostics preferences.
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The User tab, shown below, allows each Attendant Console user to set the following
options for their username.

 • Automatic Forwarding: Provides an overflow location for incoming calls. You
may specify how many calls are allowed on your extension. When this number is
exceeded, all further calls automatically forward to the specified extension. (The
number of calls for Auto Forward includes only those that are ringing. It does not
include waiting hunt group calls, connected or holding calls. A recall from hold
will not automatically forward, but will contribute to the maximum count.)
� Enable Automatic Forwarding: Enables Automatic Forwarding.
11dant Console User Guide



12
� Ringing Calls: Specifies how many calls are allowed on your extension.
When this number is exceeded, all further calls automatically forward to the
specified extension. (The number of calls for Auto Forward includes only
those that are ringing. It does not include waiting hunt group calls, connected
or holding calls. A recall from hold will not automatically forward, but will
contribute to the maximum count.)

� Forward Destination: Enter the extension number that you wish to receive
your forwarded calls.

 • Hot Dialing: Enables the number to be dialed automatically if the number
entered in the Number or Name search box matches a number in the current
Group. You do not need to press Enter. 
� Enable: Enables Hot Dialing.
� Disable When Destination Is: If desired, you can selectively disable Hot

Dialing when the destination is busy, in do-not-disturb, or forwarded by
checking the appropriate boxes.

NOTE: For the fastest transfers, set the Default Transfer Type to Immediate
Transfer and enable Hot Dialing. 

 • Skate Mode: Determines what happens to a connected call when a new call is
made. If there is not a call holding for transfer, Skate Mode is ignored and the
connected call is put on �holding for transfer� when a new call is made. 
� Skate to Hold: Places a call on hold.
� Skate to Disconnect: Disconnects a call.

 • Font Setup: Allows you to change the font type and size used for the lists.
� Change: The following dialog box appears. Select the desired font, style,

and size from the scrolling lists, then click OK to apply.

� Restore Default: Returns to the default font.
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 • Restore program when call rings: Your Attendant Console screen moves to the
front when a call rings in, or pops up the Attendant Console screen if the program
is minimized. (If you are using the Windows 98 or 2000 operating system, this
feature may not work. Instead, the Attendant Console icon will flash in the task
bar.)

 • Show hunt group calls for ACD hunt groups that I am logged in to: Calls to
the ACD hunt group that you are logged in to are displayed in the Directory List.

 • Allow hold to toggle hold: You can double-click Hold to toggle the Hold status.
 • Always show the �details� in the directory ToolTip: The directory ToolTip

will always show the details when it is displayed.
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Transfer Tab
14
The Transfer tab allows each Attendant Console user to set the following call options.

 • Default Transfer Type: Is the transfer type used when you press ENTER or use
hot dialing. Your options are Announced Transfer or Immediate Transfer.
� Announced Transfer: Places a call to the destination so you can announce

the transfer. This is the default transfer mode.
� Immediate Transfer: Transfers the call immediately, with no announce-

ment. 
 • Perform immediate transfers to hunt groups: This check box is enabled only

if the Default Transfer Type is �Announced.� The transfer call to a hunt group
overrides the default transfer type and performs immediate transfer.
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 • Perform immediate transfers to voice mail: This check box is enabled only if
the Default Transfer Type is �Announced.� The transfer call to a voice mail over-
rides the default transfer type and always performs the immediate transfer.

 • Perform immediate transfers when dragging and dropping: This check box is
enabled only if the Default Transfer Type is �Announced.� The transfer call made
by dragging a call and dropping it on a directory entry overrides the default trans-
fer type and always performs the immediate transfer.

 • Perform announced transfer to outside numbers: This check box is enabled
only if the Default Transfer Type is �Immediate.� The transfer call to an outsider
number overrides the default transfer type and always performs the announced
transfer.

 • Transfer to voice mail if transfer destination is in DND: The transfer call to a
station in do-not-disturb goes to a voice mail. (Normally, you cannot complete a
transfer to an extension in do-not-disturb.)

 • Hang-up to complete transfer: You can use the Hang Up button to complete a
transfer. If it is unchecked, you must use the Complete Transfer button. If it is
unchecked and you click Hang Up during an announcement call, the announce-
ment call is disconnected and the call waiting to be transferred remains on hold;
you can then make a new announcement call.

 • �Hold� to complete transfer to hold: You can use the Hold button to complete
a transfer and place it on hold at the destination station. If it is unchecked, you
must use the Complete To Hold button.

 • Reset the directory after an immediate transfer: The name and number fields
in the Directory list are reset after an immediate transfer.
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The Program tab defines information that the Console needs to determine, such as
which calls are local and which are toll calls. It also defines settings for the call log.

NOTE: These settings affect all Attendant Console users.

 • Get mailbox information from the telephone system: Allows you to get mail-
box information from the telephone system. The Console provides a way for you
to ignore the telephone system mailbox information and allows you to manually
set the station�s �Has Mailbox� flag.

 • Automatic Logon:
� Automatically logon to the Console as: Allows you to log on to the Con-

sole application automatically as the user selected from the drop-down when
you start the application.

� Perform system refresh at startup: Every time you startup the Console, the
system updates the database information automatically.
Inter-Tel Attendant Console User Guide
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 • Call Log:
� Log Incoming/Outgoing Calls: If you check one or both boxes in the Call

Log options, the directions (incoming or outgoing, or both) of the calls are
recorded in the Call Log. If you uncheck one or both boxes, incoming/outgo-
ing calls are not be put in the call log at all.

� Entries: Is the number of entries that will be stored in the Call Log. When
this number is exceeded, the oldest entry is deleted first. The range is 0-
3000, and the default setting is 20.

 • Offline Devices: 
� Visibly differentiate between plugged and unplugged stations/hunt

groups: If you check one or both boxes in the Offline Devices group box,
unplugged stations and hunt groups will be displayed with a slash in a circle
( ) overlayed on top of their normal status icon images. When stations and
hunt groups are unplugged, the functionality of these devices remains the
same as when they are plugged. When voice mail, mailboxes, and trunk
groups are unplugged, the user loses the ability to make a call or leave a
voice mail message to these devices (the Call and Voice Mail call handling
buttons and menus are disabled/grayed out).
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18
The Locations tab, shown below, contains a list with three columns: Node Number,
System Location, and Custom Location.

 • Show Locations in Directory: The Location column appears in the Directory
and it shows locations of all the stations.

 • Node Number and System Location: Display all the nodes that the Attendant
Console is communicating with and their locations.

 • Custom Location: Allows you to add the specific description of the system loca-
tion.
To enter a custom description for the node:
� Select the desired entry and click Edit. You can enter up to fifty characters in

a location.
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NOTE: Only an Administrator can perform the night mode configuration and on and
off. All users have the ability to view the night mode status but does not be allowed to
put nodes in or out of night mode.

The Night Mode tab, shown below, allows an Administrator to configure what will
happen when the nodes are put in Night Mode. This tab also shows the night mode
status of each node for all users. 

 • Night Mode Setup:
� Put all nodes in night mode: All nodes connected to the OAI Server are put

in and out of night mode.
� Put only my node in night mode: Only the operator�s node is put in and out

of night mode.
� Put selected nodes in night mode: Allows you to choose what nodes to put

in and out of night mode from a list. The list will contain all the nodes that
the Attendant Console is communicating with and their locations.
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To select the desired nodes:
� Check Put selected nodes in night mode, the Node list becomes

editable, as shown below. Check the desired nodes and click OK.
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The Connection tab is used to set up communication with the telephone system. This
information must be entered correctly for the Attendant Console to work. If you do
not know the information, contact your Telephone Administrator.

 • Your Station: 
� Extension: Enter your extension number.
� Node: Enter the node to which your phone is connected. 

NOTE: If you do not know which node your phone is connected, unplug and
replace your phone�s line cord. The phone shows "CKT WW:XX.YY.ZZ" on
the second line of the LCD display. The number to the left of the colon (WW)
is the node number of your phone.

� Station Password: Enter the station password programmed for your station.
(At default, this is your extension number.)

 • Reconnect: Reconnects your Attendant Console to the system.
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 • OAI Server: Allows you to specify a list of OAI Servers to which the Console
can connect. When connecting, the Console will start at the top of the list and
work its way down until it finds a server that will let it connect. Because the Con-
sole always prioritizes through the server list in a top down manner, the first OAI
Server on the list is the default primary server that the Console will connect.

NOTE: One of the main reasons for supporting this feature is to integrate the
Console with the Call Processing (CP) Server (previously called Windows NT-
based CPU). The CP Server has redundancy capabilities, and by adding redun-
dancy support to the Console, it can automatically make use of the CP Server's
redundancy feature. (The CP Server has two IP addresses that belong to it. If the
primary CPU fails then the backup CPU automatically takes over, however, the
applications connected to the primary CP Server will just �hang� unless they have
provisions for connecting to the secondary CPU.)

To add OAI Servers to the OAI Server List: 
You can add OAI Servers to the OAI Server list by clicking one of the following
buttons.

NOTE: Any OAI Server (except Axel Office Server) requires an OAI password. If
the Console cannot determine the password for the server, it prompts you to enter
the correct password. If the password you entered was incorrect, the Console asks
you if you want to add the server anyway. If you click Yes, the server will be added
to the OAI Server list. You may set the password later by clicking Edit.

� Find: Provides OAI Server information for servers on your LAN and gives
you a choice to choose OAI Servers to add to the OAI Server list. The avail-
able servers will appear in the screen, as shown below. To add a server to the
OAI Server list, highlight the desired server and click Add. You can only
add one server at a time.
� Auto Configure: Finds OAI Servers on your LAN and adds them to the OAI
Server list automatically. Servers are added to the OAI list only if they are
connected to the user�s node that have the correct premium features enabled
and use the correct system protocol version.
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� Add: Adds servers manually. When you click Add, the Add OAI Connec-
tion dialog, shown below, appears.

To add (or edit) an OAI Server:
� Click Add (or Edit). The Edit/Add OAI Connection dialog appears. 

� Enter the desired IP Address, TCP Port, OAI Password, and Description.
• IP Address: Enter the IP address of your OAI Server.

• TCP Port: Enter the port number of the OAI Server.

• OAI Password: Enter the password required by the OAI Server, if
applicable. The password may contain up to 15 characters that are case
sensitive and include any characters (i.e., numerical, alphabetical, and
symbols). Asterisks appear in place of the characters as the password
is typed.

NOTE: Axel Office Server does not require an OAI password. If there
is any password listed in the OAI Password text box, the Console will
ignore it.

• Description: Enter the description of the IP address.

� Click OK to accept the change, or Cancel to exit without making any
changes.

To remove an OAI Server:
� Highlight the OAI Server you would like to remove.
� Click Remove.
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The Warning tab allows you to choose whether you want see warning messages
before you do any of the actions listed below.

 • Exiting the Attendant Console with the close button
 • Starting a database programming session
 • Starting a system refresh
 • Resetting my call statistics
 • Deleting an Attendant Console user
 • Setting a possible invalid forward destination
 • Deleting a custom group
 • Deleting a custom directory entry
 • Deleting a custom directory entry that is a member of a custom group
 • Hiding a member of a custom group
 • Deleting OAI connection entries
 • Logging on as a user other than the user set for automatic logon
To enable a warning message:
� Check the desired warning message.
To disable a warning message:
� Uncheck the desired warning message.
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The Diagnostics tab, shown below, is used to set up log files. All commands, events,
and confirmations sent to the phone system are saved to a log file. When the file
reaches the maximum size specified in Diagnostics tab, the Attendant Console auto-
matically erases the file and starts over. If several log files are maintained, the oldest
will be erased and a new one started.

 • System Information: Indicates the Attendant Console system information. 
 • Connection Status: Allows you to see the communication status for each node.

� Node Number and Location: Display all the nodes that the Attendant Con-
sole is communicating with and their locations.

� Communication Status: 
• Communicating: A node is communicating with the Console. 

• Not Communicating: A node is not communicating with the Console.

� Details: When a node has a communication problem, the Details column dis-
plays either �Unknown,� �Serial Port Problem,� �LAN Problem,� or Node(s)
not connected.�
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 • Log Files:
� Disk Space for Log Files (Megabytes): Specifies the amount of disk space

you want to use for log files (1-20 MB). The default setting is 5 MB. Note
that the log files are always 1 MB each. Therefore, if you choose 1 MB for
disk space, the Console will make two 500 KB files.

NOTE: If there is less than 5 MB of free disk space, the oldest log file will be
deleted until there is at least 5 MB available. If there is only one log file, the
Console will stop logging. If you enter the total log file size and that number is
more than 5% of the available disk space, a warning message will appear.

� Save Log Files: The Console automatically compresses the log files. 
To save the log files:
� Click Save Log Files. The following screen appears. 

To change the location: 
� Click Browse and specify the new filename and location. The file-

name letter (�A�) will change based on the existing log files in the �log�
directory. For example, if ConsoleLogA�.zip already exists in �log,�
then the new file name will be ConsoleLogB.zip.
• Create multiple zip files to fit on floppy disks: If the Compress

(Zip) Log Files box is checked, you also have the option to create
multiple zip files so that each zip file can fit on a floppy disk.
The purpose of this option is to allow you to initially save the zip
files onto your hard drive and then later be able to transfer the zip
files onto floppy disks. The default directory and base file names
for spanned zipped files are the same as for the normal zipped log
files with the exception of the file extension. The initial file name
will be .zip but subsequent zip files will contain the extensions
in the form of  .z02, .z03 and so on, as shown on the next
page.
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available only when the Compress (Zip) Log Files checkbox is checked.
If you would like to create multiple files, as shown above, reduce the
number of bytes per log files in the Log File settings (see page 26).
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The Attendant Console program allows you to use your PC to quickly handle a large
number of calls, as well as use all of the features available through your keyset. It has
the flexibility to accommodate several user styles. If you prefer to use the mouse,
there are point-and-click options for most tasks. Or, if you like to use the keyboard,
you can use the function keys and/or other keystroke combinations. In addition, you
can set up customized �shortcut� keys and modify the display to suit your needs.
These features are also described in the Quick Reference Guide located at the front of
this book.
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MAIN ATTENDANT CONSOLE SCREEN
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The main screen of the Attendant Console has two functional areas: the call handling
and directory areas. All of which are described in the following pages. 
To resize the viewing area:
� Place the mouse pointer on the bar dividing the Call Handling and Directory

areas until it changes to a double line with arrows. Hold down the left mouse but-
ton and move the bar to the desired position, then release.
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For more details on each area, refer to the following pages:

3. Toolbars

8. Status Bar

2. Drop-Down Menus
1. Action Bar 5.Shortcut

Buttons

4. Call List

Directory

Call Handing
Area

Area

6. Directory List
7. Index Buttons
  1. Action Bar � Shows the status of the current operation. For example, if you are
dialing it displays �Dialing.� 

  2. Drop-Down Menus � See page 34 for more details.
  3. Toolbars � See page 63 for more details.
  4. Call List � See page 32 for more details.
  5. Shortcut Buttons � See page 56 for more details.
  6. Directory List � See page 44 for more details.
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  7. Index Buttons � See page 67 for more details.
  8. Status Bar � See page 65 for more details.
CALL LIST
The Call List, shown below, shows all calls currently connected, ringing, or on hold.

A connected call will have a bullet in front of the name to make it easier to find in the
list. You can view and select calls in any order. Call information is shown in columns.

• From Name: For an outside call, this shows any Caller ID text, if received, or
the Tag text that you have entered. For an intercom call, it shows the calling sta-
tion's description.

• From Number: For an outside call, this shows the phone number of the calling
party, if available. For an intercom call, it shows the caller�s extension number.

• To Name: For an outside call, it shows the Caller ID or the Tag that you have
entered, if available. For an intercom call, it shows the called station's descrip-
tion.

• To Number: For an outgoing call, this shows the telephone number or extension
that you dialed. For incoming calls it shows the number the caller dialed to reach
you.

• Elapsed: Shows the elapsed time since you received the call. By default, the Call
List is sorted according to elapsed time, with the oldest call at the top of the list.
New calls are always added to the bottom of the list.

• Type: Indicates whether the call is an intercom call (IC), an outside call (CO), or
a conference call (CNF).

• Status: This indicates call status. The possible status options are as follows:
� Blank: The status is blank if the call is at dial tone.
� Connected: You can talk to the other party
� Holding: The call is on hold at your extension.
� Holding for Transfer: The call will be on hold until you complete or cancel

the transfer.
� DND: You called an extension in do-not-disturb.
� Waiting: You called a busy hunt group and the call has camped on.
� Forwarding to XXXX: The Attendant Console is in the process of forward-

ing this call due to automatic forwarding, as configured in User Settings (see
page 11).
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� Waiting on Hold: The call is on hold at another extension.
� Waiting to Complete Transfer to VM: A transfer announcement call

reached voice mail. Complete or cancel the transfer.
� Recalling from XXXX: The call is recalling your station.
� Transfer from XXXX: The call was transferred to you.
� Forwarded from XXXX: The call was forwarded to you.
� Ringing: The call is ringing and it is not a recall, transfer, or forward call.
� Hunt Group Call: The call is ringing a hunt group that you are logged into.
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DROP-DOWN MENUS
34
There are drop-down menus on the main screen for access to various features. Several
of these menus can be accessed by selecting the right mouse button. These functions
are also available through keyboard commands or shortcut buttons (see page 33).
Many of the keyboard alternates are listed to the right of the desired option on the
menu. As with most Windows applications, menu items can also be accessed by
pressing ALT+ the underlined letter in the menu title or list.
Console Drop-Down Menu

Drop-Down Menus
When you select the Console drop-down menu, the screen, shown below, appears.
This allows you to do the following:

Log Off
This allows you to log off of the Attendant Console but does not close the application.
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Import Settings
To simplify programming configuration settings, you can import Console settings
from one PC to your Console PC. 

To import a data file:

NOTE: In order to import a data file successfully, the version of the Console and the
importing file must be the same.

  1. Click Browse and select a data file (*.czp) you wish to import. The username
that was used when the file was created will be displayed in the edit box. You
may change the username for whom the settings are being imported for, or leave
it as shown in the �Enter a username� edit box. 

  2. Check the settings you wish to import from the list and click OK.

NOTE: If the Console cannot import some or all of the settings, it will display a dia-
log stating which settings could not be imported.
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If you import settings for someone other than yourself (the user currently logged on),
the Console will display the following dialog asking whether you wish to log on as
the newly imported user. 

If you import group settings and there are groups that already exist in the Console, the
Console will display the following dialog asking whether you wish to preserve,
replace, or merge the existing group entry.
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Export Settings
This allows you to export your Console settings to other Console PCs. 
To export a data file:
  1. Select a data file (*.czp) and its location you wish to export in the dialog below.

By default, the Console exports the file to the My Documents folder. 
  2. Click OK to proceed.   

  3. The next dialog, shown below, asks you if you would like to go to the folder
where the data file is saved. Click Open Folder to open the folder or Close to
exit.
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Night Mode
The Attendant Console provides programmable night mode enabling and disabling.
The Night Mode dialog in the Console drop-down menu expands into four items:
• On: Turns on night mode.
• Off: Turns off night mode.
• View: Displays the Night Mode Status dialog box, as shown below. This shows

the night mode status for each node with which the Attendant Console is commu-
nicating. From this screen, you can also put individual nodes in and out of night
mode. 

• Configure: Displays a dialog, shown below, that allows you to configure the
nodes you want to take in and out of night mode. See page 19 for more informa-
tion on the Night Mode Option. 
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System Refresh
The Attendant Console receives data from the telephone system for page zones, direc-
tory entries, and feature codes. While the Attendant Console is running, it is able to
recognize changes in the database and update its own database. However, when the
Attendant Console is not running, changes may be made to the telephone system in
which case the Console database and telephone system may be out of sync. A system
refresh must be performed in order to sync the Console database with the telephone
system. Refer to �Performing a System Refresh� on page 10 for more details.

Options
Sets the Attendant Console properties. (See page 11 for more details.)

Configuration Wizard
Helps simplify programming various Attendant Console configuration options. The
wizard displays your current settings. You may change any settings, if desired. If you
are not sure how you would like a particular setting, it is recommended that you not
change it.

Exit
Exits the application.
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Call Handling Drop-Down Menu
40
The Call Handing drop-down menu, shown below, contains common commands used
during calls. This menu is also available by right clicking over the Call List or using
the Toolbars (see page 63 for details on toolbars). The commands and descriptions are
described in the following pages. For more details on how to handle calls, see refer-
ence pages listed in the table. 
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COMMAND MENUS TOOLBARS DESCRIPTIONS REF.
PG #

Answer Answers the call highlighted in the Call List portion 
of the main screen.

83

Hang-up Disconnects the connected call. 84

Immediate Transfer Sends the selected call directly to the selected 
directory entry, without an announcement.

85

Announced Transfer Places the connected call on transfer hold, and 
makes an announcement call to the selected direc-
tory entry so that you can announce the transfer.

86

Transfer to Voice 
Mail 

This transfers the connected call to the voice mail-
box of the selected directory entry.

86

Hold for Transfer Places the connected call on transfer hold so that 
you can make an announcement call.

86

Split Switches the call between a transfer announce-
ment call and the call that is waiting to be trans-
ferred.

88

Complete Transfer Completes an announced transfer call. 87

Complete Transfer 
to Hold 

Completes an announced transfer call and places it 
on hold at the transfer destination.

87

Cancel Transfer Cancels a call transfer with announcement. It dis-
connects the announcement call and reconnects 
the call waiting to be transferred.

87

Individual Hold Places the connected call on individual hold. If the 
�Hold to Complete Transfer Hold� box is checked in 
the User Tab (see page 11), you can also use this 
button to complete an announced transfer and 
place the call on hold at the destination station.

90

System Hold Places the connected call on System hold, which 
allows it to be picked up at any keyset station that 
has a flashing key for that outside line.

90

Conference Adds the selected call to a conference list when 
setting up a conference.

91

Leave a Message Leaves a message at the called station, then hangs 
up if you select it while you are on an intercom call. 

93
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Leave a Voice Mail Leaves a message in the mailbox associated with 
the called station while you are on an intercom call.

93

Tag Allows you to associate a name with the selected 
outside call.

84

Add to Directory Adds the selected call to your custom directory. 75, 70

-- Adjusts the volume level on your phone. 55

-- Allows you to change the appearance of the direc-
tory list.

67

-- Click this button, then place the help pointer over 
the portion on the Attendant Console where you 
need help.

--

COMMAND MENUS TOOLBARS DESCRIPTIONS REF.
PG #
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When you select the Directory drop-down menu, the following screen appears. The
options on this menu are also available by right clicking over the Directory List.
Some options are available as buttons at the bottom of the Directory List. For more
details on how to handle calls, see reference pages listed in the table below. 

The directory has the following common options:

Drop-Down Menu

Buttons

Directory List
COMMANDS DESCRIPTIONS REF. 
PAGE #

Call Places a call to the selected directory entry. 83
Voice Mail Calls the voice mailbox of the selected entry. If no entry is selected, it 

calls the general delivery mailbox.
93

Message Leaves a silent message indication at the selected station. 93
Set DND Enables or disables do-not-disturb mode for the selected station. 48
Set Forward Enables or disables call forwarding for the selected station. 48
Hide Entry Hides the selected entry (cannot be used on custom entries). 49
Custom Entry Allows you to add, edit, or remove custom entries. 50
Properties Allows a System Administrator to configure directory entry proper-

ties.
51
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Directory List
Directory information is provided by the telephone system (except custom entries).
You can update your directory by performing a system refresh, as described in �Per-
forming a System Refresh� on page 10.
The Directory List shows the device type graphically and displays the extension or
phone number in the Number column along with their respective last and first names,
status, and locations, as shown below.

To move columns:
� Simply drag column headers to the desired position, as shown below. 

To display extended information:
The Console provides extended information for stations and hunt groups in a yellow
ToolTip popup screen, as shown above. To access to this screen, do one of the follow-
ing methods:
• Highlight the desired directory entry and press Shift + Enter.
• Highlight the desired directory entry and click details> in the ToolTip.
• In Details view, by moving the mouse pointer over a selected item.
For stations, the extended information includes the number of ringing calls, the num-
ber of holding calls, a list with all the calls at the station, and a button (Pickup) for
reverse transferring a call.
Inter-Tel Attendant Console User Guide



Inter-Tel Atten

U
SIN

G
 C

O
N

SO
LE
For  ACD hun t  groups ,  t he
extended information includes a
list of all the stations logged in
and out of the hunt group as well
as the number of calls ringing
and number of available agents,
as shown on the right. 
For UCD hunt groups, only the
number of calls ringing and
number of available agents are
displayed. 
• Number or Name: You can search for a specific station by simply typing text or

digits in the Number or Name box, shown below, in the Directory. 

The Attendant Console attempts to match characters with the data in the �Last�
or �First� column and numeric characters with the data in the �Number� column.
It then selects the station with the best match. Using the following extension
example:

If you type Smith, Ja it will find all three stations. You could continue typing to
select the station with description �Smith, Jamie� or you could select the high-
lighted station. To look for a first name beginning with �Ja,� you can type a
comma and then the first letters of the name (,Ja).

NOTE: This is reversed if you rearrange the columns so that the First name
appears before the Last name. In that case, you would enter the first name before
the last name (Jamie Smith) or a comma followed by the last name (,Smith).

You can also type only the initial character of the name to search for a name. For
example, to search for Jamie Smith, you can use one of the following methods:
� If the �Last� name column is to the left of the �First� name column, type last name
initial + a comma + first name initial (s,j). 
� If you move the �First� name column to the left of the �Last� name column, type
first name initial + a space + last name initial (j s), or first name initial + a comma +
last name initial (j,s). 
Note that you are not limited to only one character. You can type more than one
character (i.e., smi,ja). 

If you type �130� it will find and select the station with extension �1300.� You
could continue typing to select the station with extension �1308.�

Smith, Jack 1308
Smith, James 1300
Smith, Jamie 1315
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 • Group: Sorts and displays different �groups� in the directory. The default groups
are Everyone, Inside Numbers, or Outside Numbers. You can also customize the
groups. For more information on how to create new groups, see page 80.

• Last, First, and Number: Displays station users� last and first names, and exten-
sion numbers.

NOTE: Speed-Dial Bin numbers display with the name or destination in the �Last�
name column and the Speed-Dial Bin number in the �First� name column.

• Status: Displays status of the stations. If a station is idle, the status column is
blank, otherwise, its status is listed. If an extension is in more than one state, all
states are listed. The Attendant Console always lists the forward path, then the
do-not-disturb message, followed by the status. See next page for status pictures.

• Location: Displays the locations of stations. This is helpful in some multi-node
situations to display the description of the node (i.e., Chandler - Node 1) where a
particular station is located. 

NOTE: See page 73 for instructions on using and customizing the Directory.
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The possible status pictures are as follows:

PICTURE DESCRIPTION
Idle telephone

Idle telephone in do-not-disturb

Idle telephone that is forwarded

Busy telephone

Busy telephone in do-not-disturb

Busy telephone that is forwarded

Ringing telephone

Ringing telephone in do-not-disturb

Ringing telephone that is forwarded

The question mark is a custom entry that the Attendant Console 
cannot identify.

The white phone is a custom entry that the Attendant Console 
recognizes as a station, but for which it cannot supply the status 
(it may be on another node).
The magnifying glass represents a hunt group.

The telephone poles are trunk groups.

The yellow book with a pen represents outside telephone num-
bers (other than speed-dial numbers).
The yellow book represents speed-dial bins.

The mailbox stands for a voice mailbox, voice mail application, 
and voice mail access extensions.
The entry is set to use Announced Transfer.
The entry is set to use Immediate Transfer.
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Set DND 
You can place any station in the directory in do-not-disturb mode. 
  1. Highlight the desired entry in the Directory.
  2. Click Set DND. The screen, shown

on the right, appears.
  3. The drop-down list box contains the

list of programmed do-not-disturb
messages for your telephone system.
Select the desired message by scroll-
ing through the list.

  4. If desired, enter text in the Second
Line edit box. 

  5. Click OK.

NOTE: The Console supports DND messages across multiple nodes. The DND
messages (00-20), shown in the Message drop-down list box above, may vary
depending on how the DND messages were programmed in each node.

Set Forward 
You can place any station in the directory in call forwarding mode. 
  1. Highlight the desired entry in the directory.
  2. Select Set Forward. The screen,

shown on the right, appears.
  3. Select the Forward type from the

scroll box. The forward options are:
Forward Off, Forward Immediate,
Forward If Busy, Forward if No
Answer, and Forward if Busy or No
Answer.

  4. Type the Forward Destination in the
text box, then click OK.

NOTE: For outside number destinations, the Attendant Console automatically
insets the outgoing feature code. Do not include the outgoing access code in the
number.
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Hide Entry
System entries can be hidden so that they no longer display in the Directory. 
To hide an entry from the Directory:
� Highlight the entry you wish to hide and right click on the mouse and then select

Hide Entry.
OR

  1. Select Hidden Entries in the Tools drop-down menu.
  2. Check Show all entries.
  3. Highlight the entry you wish to hide. To select all entries, press CTRL+A.

NOTE: To select all but a few entries, press CTRL+A to select all and then, while
holding down CTRL and using the mouse, click to unhighlight those entries that are
to be hidden.

  4. Click Hide Entry.
To display a hidden entry in the Directory: 
  1. Select Hidden Entries in the Tools drop-down menu.
  2. Check Show hidden entries only to view all the hidden entries.
  3. Highlight the entry in the Hidden Directory Entries list. To select all entries, press

CTRL+A.

NOTE: To select all but a few entries, press CTRL+A to select all and then, while
holding down CTRL and using the mouse, click to unhighlight those entries that are
to remain hidden.

  4. Select Unhide.

NOTE: If the description or number of the entry changes, the Attendant Console will
automatically unhide and display the entry in the Directory. Custom entries cannot be
hidden. (To remove custom entries from the Directory, see page 50.)
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Custom Entry
Custom entries are useful for specifying guests or for people who share a phone or
frequently called CO numbers. 
To add a custom entry:
  1. Select Custom Entry and Add from the Directory drop-down menu. The win-

dow, shown below, appears.

  2. Type the name and number. The field can contain digits (0-9), pound (#), asterisk
(*), hyphen (-), comma (,), pause (P), flash (F), explanation (!), and parenthesis (
) symbols. The Attendant Console verifies the information entered
If you want any Attendant Console user to be able to use this entry, check Every-
one can use this. 

  3. Click OK to save your changes (or click Cancel to exit without saving changes).
To edit a custom entry:
  1. Highlight the custom entry to be edited in the Directory List.
  2. Select Custom Entry and Edit from the Directory drop-down menu. The

Attendant Console displays the Edit Directory dialog, similar to the one shown
above, with the name and phone number fields filled in.
If you want any Attendant Console user to be able to use this entry, check the
Everyone can use this box. 

  3. Click OK to save your changes (or click Cancel to exit without saving changes).
To remove a custom entry:
  1. Select the custom entry that you would like to remove from the Directory List.
  2. Select Custom Entry and Remove from the Directory drop-down menu. The

warning message appears. Click Yes to remove the entry, or click No to cancel
it. 

NOTE: The Edit and Remove options work only for custom entries. You cannot edit or
remove a system entry. For information on changing system entries, see page 97.
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Properties
This option allows you to change the properties of a directory entry. Some fields are
only programmable by System Administrators. If you are not an Administrator, those
fields will be grayed out.
To program the directory entry properties: 
  1. Highlight the desired entry in the Directory list and right click on the mouse and

then select Properties.
Or, select Properties from the Directory drop-down menu. 

  2. The Properties dialog, shown on the following pages, appears. The dialog is
slightly different for each type of device.

The common fields that are programmable by any Console user are Transfer Type and
Has Mailbox. To program these fields, follow the instructions below.
• Has Mailbox: In the telephone system version 5.1, the Console has no knowl-

edge of specific voice mail boxes. Therefore, the Console assumes every station
has a voice mail box. If a station does not have a mailbox, you must uncheck
Has Mailbox in the Properties dialog. 
In the telephone system versions 5.2 and higher, the Console receives mailbox
information from the System. If the �Get mailbox information from the telephone
system� check box in the Program tab of the Options menu is not checked, you
can change the �Has Mailbox� option.

• Transfer Type: Allows you to set the transfer type for each directory entry. Each
station can be set to use the default transfer type, to use immediate transfer, or to
use announced transfer.
The Console provides a visual indication as to
what type of transfer it will perform. This
visual indication is a small icon showing the
transfer type, as shown on the right, and is for
individual station.
When you initiate a transfer to a station, the Console automatically performs the
correct type of transfer. The transfer type for each station applies to all users. If a
station is set to use immediate transfers, no matter who is using the Console, that
station will receive immediate transfers.

NOTE: Setting the transfer type in the Properties overrides both the Default
Transfer Type and the Hunt Group/Voice Mail immediate transfer options (see
page 14).

To set the transfer type:
� Click on the desired type in the Properties dialog.

� Announce Transfer
� Immediate Transfer
dant Console User Guide
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Followings are the sample dialogs for each device.
Sample Properties for Station and Single-Line Devices:

NOTE: Only a System Administrator who can provide a valid database programming
password can program the first name, last name, extension, username, attendant, and
administrator flag. If you are not an Administrator, these fields will be grayed out. 

If you made changes to the system entry, click OK. You are then prompted to enter
the database programming password, as shown below

NOTE: Without a valid password, an Administrator will not be able to change the sys-
tem entry.

John

John
Inter-Tel Attendant Console User Guide
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Sample Properties for Custom Entries:

• Everyone can use this: Allows any Console user to be able to use this entry.
• Mailbox only: Allows you to add an unassociated mailbox as a custom entry.
Sample Properties for Hunt Groups:

Smith
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Sample Properties for Trunk Groups and Voice Mails:

Sample Properties for Speed-Dial Bins:
Inter-Tel Attendant Console User Guide
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When you select the Volume drop-down menu, the following screen appears. You can
adjust the volume and set the microphone mute from the Attendant Console. Instead
of placing a call on hold, you can mute your handset or speakerphone microphone, so
that the calling party does not hear you.

Adjusting the Volume 
Do one of the following:
� Select Up or Down from the Volume drop-down menu

OR
Press CTRL+P to increase the volume or CTRL+W to lower the volume.

To save your volume settings:
� Select Save from the Volume drop-down menu.

Muting the Microphone
To mute or unmute the microphone:
� Select Mute from the Volume drop-down menu

OR
Press CTRL+U.

NOTE: When mute is on, the option will have a check, and the MUTE status bar
will lit. 
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56
When you select the Shortcuts drop-down menu, the screen, as shown below, appears.
This menu allows you to access to the features assigned to shortcut buttons 1-10. You
can customize your Attendant Console with up to 40 shortcut buttons. The buttons
can be displayed on up to four panels, each with ten buttons.
A shortcut performs a sequence of actions or dials a series of digits representing fea-
ture codes, the currently selected directory entry, or custom digits. Each action can be
one of the following:
• Dial the selected directory entry
• Dial custom digits
• Dial a feature code
• Perform a telephone feature (transfer, hang-up, answer)
• Activate a specific tab or group
• Tag a call
• Pause for one second 
To display the shortcut buttons in the Main Attendant Console screen:
  1. Select the desired shortcut panel(s) from the View drop-down menu. The Short-

cut buttons appear on the main screen, as shown below. 

Shortcut PanelsShortcut Drop-Down Menu
Inter-Tel Attendant Console User Guide
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At default, the shortcuts are:

  2. You have two options for using the shortcuts:
 • Select a displayed shortcuts button on the right side of the main screen.
 • Select a desired Shortcut from the Shortcuts drop-down menu. 

NOTE: The first ten shortcuts can be accessed by pressing CTRL+number 0-9.
The CTRL keys work even if the first ten are programmed differently from their
default values. For example, if you change the Imm. Transfer button to Answer, the
CTRL+1 will now answer a call and not perform the Imm. Transfer.

SHORTCUT BUTTON SHORTCUT KEY DESCRIPTION
Immediate Transfer CTRL+1 Transfers a call without an announce-

ment.
Annc. Transfer CTRL+2 Transfers a call with an announcement.

Dial # CTRL+3 Dials a pound (#).
Reverse Transfer CTRL+4 Reverse transfers a call from the exten-

sion entered in the Directory.
At Lunch CTRL+5 Enters the �Out to Lunch� do-not-disturb 

message.
Gone Home CTRL+6 Enters the �Gone Home� do-not-disturb 

message.
DND Off CTRL+7 Turns off do-not-disturb.

Dial * CTRL+8 Dials an asterisk (*).
Forward All to 1000 CTRL+9 Forwards all calls to the operator (exten-

sion 1000).
Forward Off CTRL+0 Turns off call forwarding.
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Setup Shortcuts
A shortcut performs a sequence of actions or dials a series of digits representing fea-
ture codes, the currently selected directory entry, or custom digits. Each action can be
one of the following:
• Dial the selected directory entry
• Dial custom digits
• Dial a feature code
• Perform a telephone feature (transfer, hang-up, answer)
• Activate a specific tab or group
• Tag a call
• Pause for one second 
To program shortcuts, do the following:
  1. Either select Setup Shortcuts from the Shortcuts drop-down menu or Setup

by right clicking on a shortcut button and launching the wizard from the context
menu. The screen, shown below, appears. 

NOTE: To display the shortcut panels on the Attendant Console screen, select
Shortcut Panel 1-4 in the View drop-down menu.

  2. If you prefer not to show the Welcome page again, check Do not show this
Welcome page again. To continue, click Next.

NOTE: If you would like to reinstate the Welcome page, select Setup Shortcuts
from the Shortcuts drop-down menu, click Back and uncheck the Do not show
this Welcome page again.
Inter-Tel Attendant Console User Guide
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  3. Select a shortcut you would like to program from any of the function keys (F2 -
F12), the keypad keys (/, *, -, +), or any of the 40 shortcut buttons (ten per panel).
The default settings are shown on the next page. After selecting the desired short-
cut, click Next. The screen, shown on step 4., appears. 
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  4. To assign a name to the short-
cut button, enter the name in
the Name Shortcut text box.
Then, click Next. The screen,
shown on the next page,
appears. To return to the previ-
ous screen, click Back. To
cancel the programming with-
out changing, click Cancel. 

TREES DEFAULT SETTINGS

Function Keys (F2-F12) F2: Outside Numbers
F3: <available>
F4: Split
F5: <available>
F6: Cancel Transfer
F7: Transfer to Voice Mail
F8: Complete Transfer
F9: Answer
F10: Hold
F11: <available>
F12: Hang-up

Keypad Keys (/*-+) keypad /: Immediate Transfer
keypad *: Split
keypad -: Cancel Transfer
keypad +: Complete Transfer

Button Panel 1 Button 1: Imm. Transfer
Button 2: Annc. Transfer
Button 3: Dial #
Button 4: Reverse Transfer
Button 5: At Lunch
Button 6: Gone Home
Button 7: DND Off
Button 8: Dial *
Button 9: Fwd All to 1000
Button 10: Fwd Off

Button panel 2 Button 1-10: <available>
Button panel 3 Button 1-10: <available>
Button panel 4 Button 1-10: <available>
Inter-Tel Attendant Console User Guide
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  5. Select actions you would like the shortcut to perform. When you select an action
from the All Actions list, a brief description of the action appears under the list.

To add an action: 
� Select the desired action from the All Actions list and click Add->. The

action moves to the Shortcut Actions list.

NOTE: You can include up to five actions in one shortcut. When five actions
are reached, the Add button becomes disabled (grayed out). 

To delete an action:
� Select the action to be removed from the Shortcut Actions list and click <-

Remove.
  6. If the action you added requires more information, a dialog will prompt you to

enter the necessary information. For example, when you select DND (set) from
the All Actions list, the following screen appears.   

  7. After adding the shortcut actions, you may use the up and down arrow buttons to
change the order of the actions, or select the action and click Edit to change the
action specific information. Then, click Next. The last screen, shown on the next
page, appears. 
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  8. This screen provides you a summary of the shortcut that you just setup and then
give you two choices:

 • Exit the shortcut setup wizard: Closes the wizard and returns to normal
Attendant Console operation.

 • Setup another shortcut: Takes you back to the first step. The Finish button
changes to the Next button.

  9. After selecting one of the above selections, click Finish to complete the pro-
gramming or Cancel to finish it without changing.
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options in this menu determine which elements are included in the main Attendant
Console screen.

Toolbars
You can select toolbars, shown below, to be displayed on the main screen. You can
change their position using the Customize Toolbar menu. You can click buttons to
perform various call handling tasks, adjust volume, and access Help. The commands
and descriptions are described on page 40. 
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To display toolbar(s):

� Select Toolbar from the View drop-down menu. 
To customize toolbar(s):
� Select Customize Toolbar from the View drop-down menu. Then, follow the

instructions on the next page.
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Customize Toolbar
When you select Customize Toolbar from the View drop-down menu, the follow-
ing dialog appears. This allows you to choose toolbar buttons that are to be displayed
on the Toolbar. After adding buttons, click Close. The new buttons appear on the
Toolbar.

To add a button:
� Highlight the desired button in the Available toolbar buttons list box and click

Add->. The toolbar will be inserted above the highlighted button in the Current
toolbar buttons list box.

To change the order of the button(s):
� Highlight the button to be moved in the Current toolbar buttons list box and click

Move Up or Move Down.
To remove a toolbar:
� Highlight the button to be removed in the Current toolbar buttons list box and

click <-Remove.
To remove text labels from the toolbar:
� Select No text labels from the Text Options drop-down list box.
To show text labels in the toolbar:
� Select Show text labels from the Text Options drop-down list box.
To default the Toolbar:
� Click Reset.
Inter-Tel Attendant Console User Guide
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Status Bar
You can display or not display the status bar on the bottom of the Main Console
screen. The status bar shows the purpose of the selected menu item or tool bar button,
and the status of the selected directory entry. Error messages may also appear on the
status bar.
To display the Status Bar:
� Select Status Bar from the Toolbars menu in the View drop-down menu. The

status bar, as shown below, appears.

On the right-hand side of the status bar, there are six boxes. These boxes display short
messages indicating when the listed features are enabled or a message is waiting. The
features are, in order:

STATUS 
BUTTON DESCRIPTIONS

DND When not in DND, the DND area is grayed put. When in DND, the sta-
tus area turns red (red is used in the directory to signify DND). If you 
right click on the status area, a menu appears that allows you to turn 
DND on or off for your station.

FWD When not forwarded, the FWD area is grayed put. When forwarded, 
the status area turns blue (blue is used in the directory to signify for-
ward). If you right click on the status area, a menu appears that allows 
you to turn forwarding on or off for your station, as shown below. 

MSG Message Received. When there are messages, the status area turns 
green. You can either double click the MSG area to display the Mes-
sages dialog, or you can right click to display a menu that will bring up 
the message dialog

MUTE When not connected to a call, the mute area is grayed put. When con-
nected to a call and not muted, the MUTE area is visible. When con-
nected to a call and muted, the status area turns red. You can double-
click the mute area to toggle the mute status, or right click to display a 
menu that will toggle mute.

LINK When all OAI connections are up, the LINK button is grayed put. This 
status indicates that the Console is connected to an OAI Server. If one 
or more connections are down, the status area turns yellow. You can 
double-click the link status area to display the connection status (see 
page 25), or right click to display a menu that will bring up the connec-
tion status.
65
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NGT:OFF When all nodes are in day mode, the night mode area displays 
�NGT:OFF.� 

NGT:ON When all nodes are in night mode, the status area turns red and 
"NGT:ON" is displayed. 
Continued on the next page.

NGT:* If some nodes are in night mode and some are not, the status area 
turns yellow and the �NGT: *� is displayed. 
You can double-click the night mode status area to view the current 
night mode status of each node, as show below. 

If you are an Administrator, you can turn the Night Mode On and Off 
from this screen by clicking the Night On or Night Off button. 
You can also right click the status area to display a menu that will allow 
you to turn on night mode, turn off night mode, view the current night 
mode status, and configure how night mode is enabled and disabled, 
as shown below. (Selecting Configure will display the Night Mode 
option page, shown on page 19.)

NOTE: The night mode status is based on how the user has night
mode configured, not necessarily all the nodes the Console is commu-
nicating with. Only an Administrator can turn the Night Mode on and
off.

STATUS 
BUTTON DESCRIPTIONS
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Directory
When you select Directory from the View drop-down menu, the following screen
appears. The options in this menu determine how the directory list will appear in the
main screen. 

The following options are available:
• Details: Displays last and first names, extension numbers, location, and status in

small fonts. This is the default mode.
• Large Icons: Displays large icons with last/first names and extension numbers.

The status, such as DND and FWD, are visible as icons. 
• Sort by Last Name, First Name, Number, or Location: Sorts Directory list in

ascending order based on the column selected. By default, the list is sorted by last
name. You can also sort columns by clicking on the column header you want to
sort by. 

NOTE: You cannot sort the directory while searching. For example, if you type
�123� in the Number or Name field, the directory will automatically be sorted by
number.

• Show Index Buttons: Allows you to search the directory using the
alphabet index buttons. When this menu option is selected, the index
buttons, shown on the right, appear on the right side of the directory list.
Click a button that contains an initial letter of the desired name you are
searching for.

NOTE: If the directory is currently sorted by last/first name, the 123
index button will display all entries containing numbers as the first charac-
ter in their last/first name column.

.

.

.

67dant Console User Guide



68
 • Show Transfer Indicator: Displays symbols of the transfer type (Immediate or
Announced), shown below, next to the large icons for each directory entry.

• Show Locations: Displays the locations for each directory entry. 

NOTE: This does not apply to the Large Icons mode. In Large Icons mode, the
location is displayed in the ToolTip popup screen.

Shortcut Panels 1-4
The shortcut panels display up to 40 customized shortcut buttons on the Console main
screen. The panels can be �docked� on the left or right of the screen or �floated� any-
where on the screen. Each shortcut panel contains 10 shortcut buttons. To customize a
shortcut button, see page 56.
To display the shortcut panels in the Main Console screen:
� Select the desired shortcut panel(s) from the View drop-down menu. 

� Announce Transfer
� Immediate Transfer
Inter-Tel Attendant Console User Guide
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When you select the Tools drop-down menu, the following screen appears. The
options in the menu allow you to program and/or operate various features. 

Customize Directory
When you select Customize Directory (or press CTRL+S) from the Tools drop-
down menu, the following screen appears. Custom entries are useful for specifying
guests or for people who share a phone or frequently called CO numbers.
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To add a custom entry:
  1. Click Add Entry from the Custom Directory dialog or select Add To Direc-

tory from the Call Handling drop-down menu. The window, shown below,
appears.

  2. Type the name and number. The field can contain digits (0-9), pound (#), asterisk
(*), hyphen (-), comma (,), pause (P), flash (F), explanation (!), and parenthesis (
) symbols. The Attendant Console verifies the information entered
If you want any Attendant Console user to be able to use this entry, check Every-
one can use this. 

  3. Click OK to save your changes (or click Cancel to exit without saving changes).
To edit a custom entry:
  1. Highlight the custom entry to be edited in the Directory List.
  2. Click Edit from the Custom Directory dialog. The Attendant Console displays

the Edit Directory dialog, similar to the one shown above, with the name and
phone number fields filled in.
If you want any Attendant Console user to be able to use this entry, check the
Everyone can use this box. 

  3. Click OK to save your changes (or click Cancel to exit without saving changes).
To remove a custom entry:
  1. Highlight the custom entry to be removed in the Directory List.
  2. Click Remove from the Customize Directory dialog.

NOTE: The Edit and Remove options work only for custom entries. You cannot edit or
remove a system entry. For information on changing system entries, see page 97.
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Group Setup
When you select Group Setup from the Tools drop-down menu, the following
screen appears. This screen allows you to create new group(s) for the Directory. You
can use groups to control the displayed extension list in the Directory for easy access.
In the default Attendant Console database, there are three groups: Inside Numbers,
Outside Numbers, and Everyone. These default groups cannot be modified.

• All Available Directory Entries and Directory Entries in Group: Display sta-
tion user�s last and first names, extension numbers, and the locations of stations. 

• Device Count: Displays the number of the stations available in the Group at the
bottom of the screen.

To create groups:
  1. Click New. The screen on the right appears.
  2. Enter the name of the group in the text area

of the dialog box.
  3. Check Everyone can use this if you

want all Attendant Console users to use the
group.

  4. Click OK.
To move an entry from the All available directory entries list: Highlight the entry
and click Add. Or, double-click the entry in the Available list. As you add or
delete names, the Directory Entries in Group list will be updated. 
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NOTE: To select all but a few entries, press CTRL+A to select all and then, while
holding down CTRL and using the mouse, click to unhighlight those entries that are
not to be added.

To add all the list entries: Click Add All.
To delete a name from the Device Entries in Group list: Highlight the name and
click Remove. 

NOTE: To select all but a few entries, press CTRL+A to select all and then, while
holding down CTRL and using the mouse, click to unhighlight those entries that are
not to be deleted.

To remove all entries from the list: click Remove All.
To change group properties:
  1. Select the group that you want to change

from the scroll box.
  2. Click Edit. The screen, shown on the right,

appears.
  3. Edit the information as needed and click

OK.
To delete a group:
  1. Select the group that you want to delete from the scroll box.
  2. Click Delete.
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Hidden Entries
When you select Hidden Entries from the Tools drop-down menu, the following
screen appears. 

To view all entries:
� Check Show all entries.
To view hidden entries only:
� Check Show hidden entries only.
To display a hidden entry: 
  1. Highlight the entry in the Hidden Directory Entries list.

NOTE: To select all but a few entries, press CTRL+A to select all and then, while
holding down CTRL and using the mouse, click to unhighlight those entries that are
to remain hidden.

  2. Click Unhide.
To hide an entry:
  1. Select Show all entries and highlight the desired entry you want to hide. 

NOTE: To select all but a few entries, press CTRL+A to select all and then, while
holding down CTRL and using the mouse, click to unhighlight those entries that are
not to be hidden.

  2. Click Hide.

NOTE: If the description or number of the entry changes, the Attendant Console will
automatically unhide and display the entry in the Directory. Custom entries cannot be
hidden. (To remove custom entries from the Directory, see the section, �To remove a
custom entry:� on page 70.)
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Call Log
When you select Call Log (or press CTRL+L) from the Tools drop-down menu, the
following screen appears. This screen provides you with a record of the called name,
number, type, date, call start time, and call elapsed time, direction (incoming or out-
going), and if the call was answered or not. 

NOTE: The direction is relative to the operator�s phone, not the telephone system. For
example, if a call is transferred to the Console user, that call will always be considered
as an incoming call regardless of whether the call is originated from another extension
or the outside number.

The logs are listed in the order they were disconnected. Your Attendant Console�s
setup determines how many calls are stored in the log (see page 25). The range is 0-
3000.
You can place calls from the Call Log, remove entries, or move entries to your Direc-
tory, as described below.
To dial a number using the Call Log, do one of the following:

� Click Call or press ENTER while the call is highlighted in the list.

OR
Double-click on an entry in the list.

NOTE: When you call a number from the Call Log, the area code is not dialed if it
matches your home area code. The Attendant Console gives you the option of edit-
ing the phone number before dialing by displaying the number.

To remove a Call Log entry: 
� Highlight the desired entry.
� Click Remove.
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To remove multiple Call Log entry: 
� Select the desired entries by clicking the entries while holding down CTRL.

NOTE: To select all but a few entries, press CTRL+A to select all and then, while
holding down CTRL and using the mouse, click to unhighlight those entries that are
not to be removed.

� Click Remove.
To remove all Call Log entries: 
� Click Remove All.
To move a Call Log entry to your Directory: 
� Highlight the entry.
� Click Add To Directory.
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Statistics
When you select Statistics from the Tools drop-down menu, the following screen
appears. Call handling statistics are tracked by the Attendant Console. You can also
view cumulative statistics by opening the archive files that are stored in the Attendant
Console/Stats directory.

• Statistics:
� Calls that Rang in: Shows the number of incoming IC and CO calls. If there

is an outgoing call that is placed on hold and it recalls, it is not counted as a
call that rang in. Incoming transfers are not counted because the announce-
ment call will be counted. This also does not include calls that automatically
forwarded.

� Calls Placed on Hold: Shows the number of the IC and CO calls placed on
individual hold. It does not include calls placed on transfer hold. If a call is
placed on hold multiple times, it is counted multiple times.

� Calls that Recalled: Shows the number of IC and CO calls that recalled
from hold. It does not include calls that recalled from a transfer. If a call
recalls multiple times, it is counted multiple times.

� Calls Handled: Every time an IC or CO call leaves the operator, it was han-
dled, unless it was on hold, was ringing, or was a transfer announcement call.
When a conference is made each call in the conference is counted as handled
and the conference call is treated as a new call. Calls that automatically for-
ward are not counted as handled.
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� Calls that Automatically Forwarded: Counts increases every time the
Console automatically forwards a call.

� Abandoned Calls: Displays a CO call that rang in but was never answered.
This does not include calls that automatically forwarded.

� Percent of Calls that Recalled: Shows the percentage of calls placed on
hold that recalled. It does not include calls placed on transfer hold.

� Average Ring Time: Shows the average time that incoming IC and CO calls
were ringing, not including recalling. This does not include the ring time for
calls that automatically forwarded.

� Average Recall Time: Shows the average time IC and CO calls spent recall-
ing.

� Average Hold Time: Shows the average time IC and CO calls were on indi-
vidual hold, not including time that they are recalling from hold.

� Total Talk Time: Shows the total time the Attendant Console was connected
to both IC and CO calls.

• Reset Statistics Daily: Unless you check this box to clear the statistics screen at
midnight each day, the statistics are gathered until you clear them (as described
below). 

• Reset Statistics: To clear the statistics display, click Reset Statistics. Clearing
the statistics screen affects only this dialog box; it does not affect the archived
statistics files that are stored on your PC.

• Help: Provides access to the Attendant Console Help files.

NOTE: When a user logs off with active calls, the call statistic times are treated as
though the call disconnected at that time. When a user logs on with active calls, the call
statistic times start from the time they log on.

Viewing Archived Statistics: Allows you to keep a record of the statistics for two
months. Complete statistics are archived on your PC, in the Attendant Console/Stats
directory, so that they can be obtained later. The saved statistics are categorized by
month. There are two statistics files: one for the current month, and one for the previ-
ous month. The files are named this_month.csv and last_month.csv and
they can be viewed using Microsoft Excel (or any program that reads comma-sepa-
rated value files). The previous month�s file will be overwritten at the end of the cur-
rent month.
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Conference
When you select Conference (or press CTRL+R) from the Tools drop-down menu,
the following screen appears. This screen indicates the status of conference setup. You
cannot build a conference call using this screen. To build a conference, refer to
�Building a Conference� on page 91.

Dial Pad
When you select Dial Pad (or press CTRL+D) from the Tools drop-down menu, the
following screen appears. This allows you to use dial pad on the screen. The dial pad
can float anywhere on the screen.
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Feature Codes
When you select Feature Codes (or press CTRL+F) from the Tools drop-down
menu, the following screen appears. You can select a feature code and execute it. This
gives you access to station features that are not included on the main Attendant Con-
sole.

The Feature Codes list is an alphabetical listing of telephone system feature names
and feature codes.
To use a system feature code, do one of the following:
  1. If the feature code will require additional digits, enter them in the Number box.

Or, to use the entry highlighted in the Directory, check Use Directory.
  2. Highlight the desired feature code in the list and then click Execute.

OR
Double-click the desired feature code.
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Messages
When you select Messages (or press CTRL+M) from the Tools drop-down menu or
press lit MSG status bar, the following screen appears. This dialog provides informa-
tion on any messages that are waiting at your station. It tells you the source of the
messages, time and date stamp, and the number of the messages. See page 94 for
details on how to respond to a message.

NOTE: If a station-to-station message is left more than once between the same two
extension numbers, the message count will only display 1.
Inter-Tel Attendant Console User Guide



Inter-Tel Atten

U
SIN

G
 C

O
N

SO
LE
Page Zones
When you select Page Zones (or press CTRL+G) from the Tools drop-down menu,
the following screen appears. The Paging feature allows you to make announcements
through phone speakers and/or through optional external paging equipment.

To make a page: 
  1. Highlight the desired page zone and press ENTER or click Begin Page.

OR
Double-click on the desired page zone.

  2. Make your announcement before the Paging timer expires, then hang up.

Database Programming
Any Administrator station can perform database programming using the Attendant
Console. The following fields are programmable using the Attendant Console Data-
base Programming:
� Station information for individual stations
� DND and Reminder messages
For more information on how to program, refer to �Programming Station Informa-
tion� on page 97.
81dant Console User Guide



Help Drop-Down Menu
82
When you select Help from the Tools drop-down menu, the following menu appears.
Select this menu for access to Attendant Console Help and information on the Atten-
dant Console software.

• Contents: Displays the contents of the help file.
• Requirements: Displays Software and Hardware requirements. See page 4 for

more details.
• Troubleshooting: Displays troubleshooting information.
• Send Feedback: Allows you to send comments to Inter-Tel. If you would like to

send feedback to Inter-Tel, enter the required information in the form and click
Send.
� Clear Form: Clears all the fields.
� Print Form: Launches Notepad and automatically prints the form.
� Send: Sends the feedback form to Inter-Tel.

• Product Registration: Displays the Product Registration form. If you would like
to perform online registration, enter the required information in the form and
click Send.
� Clear Form: Clears all the fields.
� Print Form: Launches Notepad and automatically prints the form.
� Register: Sends the registration information to Inter-Tel.

• About Attendant Console: Displays Attendant Console version information.
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To place a call:
  1. Select Number or Name in the Directory and begin typing the name or the tele-

phone number you wish to dial. The Attendant Console searches the directory for
the name or number as you type it, and displays a list of partial matches. To
decrease the number of matches, continue to enter characters and narrow the
search until you can see the name or number you want to select.

NOTE: The Attendant Console searches only the first column when you type a
name. If you type a number that does not match a directory entry, the Attendant
Console can still call that number. However, if you type a name that does not match
a directory entry, the Attendant Console cannot make a call. 

  2. Place a call in one of the following ways:
� Press ENTER or click Call when the call is highlighted in the Directory.

OR
Double-click on the entry in the Directory.

To place a call to a voice mailbox:
� Click Voice Mail in the Directory.
SO
LE
Answering Calls

Incoming calls appear in the Call List in the order received, with the oldest call at the
top of the list. 
To answer a call, do one of the following:
� Click Answer in the Toolbar

OR
Select Answer from the Call Handling drop-down menu.
OR
Press the Answer function key (defaults to F9)
OR
Double-click on the desired call in the Call List
OR
Highlight the desired call in the Call List and press ENTER.

NOTE: When you answer a call, the system hangs up the currently connected call or
�skates� it to hold, depending on your User Settings (see page 11). If you are paging or
connected to voice mail, answering a new call will always disconnect the page or call. 
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Tagging Calls
You can specify a name for an outside call with the tagging feature. A record of the
call will be stored in your Call Log with the new information. The new name will stay
with the call if it moves to other stations in the telephone system.
Highlight the call in the Call List and then do one of the following:
� Press CTRL+T

OR
Click Tag Call from the Toolbar
OR
Select Tag from the Call Handling drop-down menu.

When the edit box displays, type the name (Tag) you wish to associate with the call
and press enter.
Hanging Up

Hang-Up ends an operation or disconnects a call, the same as hanging up the handset
on your phone. 
To hang up, do one of the following:
� Click Hang-up from the Toolbar

OR
Select Hang-Up from the Call Handling drop-down menu
OR
Press the Hang-Up function key (defaults to F12).
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There are several options for the type of transfer that takes place when you select a
destination using the Directory. Initially, you need to set the default transfer mode in
the Transfer Options page (see page 14).
The User Settings that affect call transfers are:
� Default Transfer Type
� Hot Dialing

TIP: For the fastest transfers, set the Default Transfer Type to Immediate Transfer and
enable Hot Dialing. 

Immediate Transfer
To transfer a call immediately, with no announcement, do one of the following:
� Press CTRL+1

OR
Select the destination number in the Directory, then click Transfer from the Tool-
bar
OR
Select Immediate Transfer from the Call Handling drop-down menu.

To transfer a call immediately without answering:
� Simply drag and drop the highlighted call in the Call List to the destination num-

ber in the Directory List. 

NOTE: This method overrides any of the default transfers: the Default Transfer Type,
the Hunt Group/Voice Mail immediate transfer options, and the Transfer Type options
(see pages 14 and 51 respectively).
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Announced Transfer
To place a call to the destination so you can announce the transfer, do one of the fol-
lowing:
� Press CTRL+2

OR
Click Annc Trans from the Toolbar
OR
Select Announced Transfer from the Call Handling drop-down menu.

� Then, Complete transfer.

NOTE: This method overrides any of the default transfers: the Default Transfer Type,
the Hunt Group/Voice Mail immediate transfer options, and the Transfer Type options
(see pages 14 and 51 respectively).

Holding for Announced Transfer
To place a call on transfer hold before announceing the transfer, do one of the fol-
lowing:
� Click Trans Hold from the Toolbar

OR
Select Hold for Transfer from the Call Handling drop-down menu.

� Then, Complete transfer.
Transferring to Voice Mail
� Select the destination number in the directory, and click Voice Mail in the direc-

tory or press CTRL+ENTER
OR
Click Trans VM from the Toolbar
OR
Selecting Transfer to Voice Mail from the Call Handling drop-down menu.
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Canceling a Transfer
You can cancel a transfer at any time before the transfer is completed. 
To cancel a transfer, do one of the following:
� Click Cancel Trn. from the Toolbar

OR
Select Cancel Transfer from the Call Handling drop-down menu
OR 
Press the Cancel Transfer function key (defaults to F6).

Transferring a Call with Hot Dialing
Enter the destination number in the directory Name or Number box. This will auto-
matically make the announcement call or immediately transfer the call to the number,
depending on your User Settings.
To end an announcement call and complete the transfer, do one of the following:
� Click Complete from the Toolbar

OR
Select Complete Transfer from the Call Handling drop-down menu (if you
have �Hangup� To Complete Transfer Hold enabled, press Hang Up or F12)
OR 
Press the Complete Transfer function key (defaults to F8).

To place the call on hold at the destination station, do one of the following:
� Click Comp.Hold from the Toolbar

OR
Select Complete To Hold from the Call Handling drop-down menu (if you have
�Hold� To Complete Transfer Hold enabled, press Hold or F10).
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Transferring a Call without Hot Dialing
  1. Select or enter the destination number in the Name or Number box. 
  2. Press ENTER to make the announcement call or transfer the call to the number,

depending on your User Settings.
To end an announcement call and complete the transfer, do one of the follow-
ing: 
� Click Complete from the Toolbar

OR
Select Complete Transfer from the Call Handling drop-down menu (if
you have Hung up To Complete Transfer enabled, you can press Hang Up
or F12)
OR 
Press the Complete Transfer function key (defaults to F8).

To place the call on hold at the destination station, do one of the following:
� Click Comp.Hold from the Toolbar

OR
Select Complete Transfer To Hold from the Call Handling drop-down
menu (if you have �Hold� To Complete Transfer Hold enabled, you can
press Hold or F10).

Split between the Announcement Call and Transfer Party
While on an announcement call, if you wish to return to the party waiting to be
transferred, do one of the following:
� Click Split from the Toolbar

OR
Select Split from the Call Handling drop-down menu
OR 
Press the Split function key (defaults to F4).

To return to the announcement call:
� Select Split again. These steps can be repeated as often as necessary.
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Canceling a Transfer
You can cancel a transfer at any time before the transfer is completed. Do one of the
following:

� Click Cancel Trn. from the Toolbar
OR 
Press the Cancel Transfer function key (defaults to F6)
OR
Select Cancel Transfer from the Call Handling drop-down menu.
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Putting Calls on Hold
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• Individual Hold: Putting a call on Individual Hold makes it available only at
your station. 
To place a call on Individual Hold, do one of the following:
� Click Hold from the Toolbar 

OR
Select Individual Hold from the Call Handling drop-down menu
OR
Press the Hold function key (defaults to F10).

To return to the call on Individual Hold, do one of the following:
� Click Answer from the Toolbar 

OR
Press the Answer function key (defaults to F9). (If you have �Allow Hold To
Toggle Hold enabled, you can press Hold to take the call off hold)

• System Hold: If you put a call on System Hold, it can be picked up at your sta-
tion or at any keyset that has a flashing key for that outside line. 
To place a call on System Hold, do one of the following: 
� Click Sys Hold from the Toolbar

OR
Select System Hold from the Call Handling drop-down menu.
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Multi-party conference calls can be established using the Conference Setup dialog
controls. The dialog is accessed by selecting Conference from the Tools drop-down
menu. In addition to your station, the conference can include up to four parties
(including you) in any combination of intercom and outside calls. Establishing a con-
ference is done in two steps: building the conference and connecting the conference.

Building a Conference
You can build a conference from calls that are either connected or on individual hold
in the main Call List. You cannot add ringing calls.
  1. Highlight the desired call in the Call List.

Do one of the following. 
� Press CTRL+N (this option is available only while you are on a call)

OR
Press CTRL+R
OR
Click Conference from the Toolbar. The following screen appears.

NOTE: If you pressed CTRL+N, skip step 2.

  2. Drag and drop the highlighted call onto the Conference Setup dialog. 
  3. The Attendant Console copies the call into the Conference Setup list, as shown

below. 
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NOTE: The call still appears in the Call List. If one of the calls is on hold or not
connected, the Begin button will be grayed out.

  4. Repeat steps 1 and 2 for all calls to be included in the conference.
If you copy the wrong call into the Conference Setup list, remove it by highlight-
ing it in the Conference Setup list and clicking Remove Call. This does not
affect the Call List, only the Conference Setup list.

NOTE: There is no active conference yet. 

Connecting a Conference
When you have built your Conference list, you are ready to connect the conference
call.
� Click Begin on the Conference dialog. The Attendant Console removes all

entries from the Conference Setup list, removes the individual calls from your
Call List, and adds the conference call as a connected call in the Call List.

Adding a Call to the Conference
During a conference, if you want to add a party, do the following:
  1. Place the conference on hold by moving it to the Conference Setup dialog, as

described above.
  2. Place a call to the party you wish to add and move that call to the Conference

Setup dialog.
  3. Click Begin.
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In telephone system version 5.1, the Attendant Console has no knowledge of specific
voice mail boxes, as it does not receive information about them. Therefore, the Atten-
dant Console assumes every station has a voice mail box. If a station does not have a
mailbox, you must highlight the station in the directory and uncheck Has Mailbox in
the Directory Entry Properties dialog. The Attendant Console will not automatically
obtain information about unassociated mailboxes. To add unassociated mailboxes to
the Directory, add a custom entry and check Mailbox Only in the Custom Directory
Properties dialog (see page 51).
In telephone system versions 5.2 and higher, the Attendant Console receives mailbox
information from the System. If the �Get mailbox information from the telephone sys-
tem� check box on the Program tab of the Options frame is not checked, you can
change the �Has Mailbox� option.
When calling a station, if you hear a busy signal, do-not-disturb signal, or the call is
not answered, you can leave a message at the station or in voice mail. 

Leaving a Message
To leave a message at the station, do one of the following:
� Press CTRL+E

OR
Click Mess. Call from the Toolbar.

To leave a voice mail message, do one of the following:
� Press CTRL+O

OR
Click Leave VM from the Toolbar. 

To leave a message without placing a call (Silent Message):
� Select an entry in the Directory, and then click Message in the directory. 
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Responding to a Message
If you have waiting messages, the message indicator on the status bar is highlighted
green, as shown below.

When you double-click MSG, the following screen appears. Each message is identi-
fied with the source of the message, time and date stamp, and the number of the mes-
sages from the messaging station.

NOTE: If a station-to-station message is left more than once between the same two
extension numbers, the message count will only display �1.�

Do one of the following:
� Highlight the message and click Reply

OR
Double-click on the message.

When you have responded to a message, the Attendant Console removes that message
from the message list. However, if you do not save or delete a voice mail message, the
Voice Processing Unit will restore the message indications.
If the called station is unavailable (does not answer the call, is busy, or is in do-not-
disturb), the message remains in the list and you can try again later, or leave your own
message for that station. The user can view a list of waiting messages by selecting
Messages from the Tools drop-down menu or by double-clicking MSG on the sta-
tus bar
To remove a message without responding: 
� From the Messages dialog (displayed through the Tools drop-down menu), high-

light the message and click Remove.
To remove all the messages in the list: 
� From the Messages dialog, click Remove All.
Inter-Tel Attendant Console User Guide



Inter-Tel Atten
Removing a Message
To remove a message without responding:
� From the Messages dialog (displayed through the Tools drop-down menu), high-

light the message and click Remove.

NOTE: The message is only removed from the list and it stays in the voice mail
box until it is deleted from the voice mail box.

To remove all the messages in the list:
� From the Messages dialog, click Remove All.
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To dial a feature code while you are connected to a call:
� Press ALT+SHIFT+1 to dial SPCL.Then, do one of the following:
� Dial the digit(s) by pressing the buttons on the Attendant Console Dial Pad. To

display the Dial Pad, Select Dial Pad from the Tools pull-down menu (or press
CTRL+D).
OR
Press and hold ALT while typing the number you want to dial (i.e., 385 for the
Record A Call feature) in the Number or Name text box.

NOTE: In addition, you can press ALT+SHIFT+3 to dial a pound and
ALT+SHIFT+8 to dial an asterisk.

To dial a feature code when you are not dialing over a call:
� Type the exclamation point (!) followed by the feature code you want to dial in

the Number or Name text box. The Console interprets the exclamation point as
the keyset�s SPCL key.
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Some telephone systems may require you to enter digit(s) to reach a destination. For
example, when calling a company�s support telephone number, the company�s tele-
phone system might guide you to dial 1 to select a technical support group.

To dial digit(s) while you are connected to a call, do one of the following:
� Dial the digit(s) by clicking the buttons on the Attendant Console Dial Pad. To

display the Dial Pad, Select Dial Pad from the Tools pull-down menu (or press
CTRL+D)
OR
Press and hold ALT while typing the number you want to dial.

NOTE: In addition, you can press ALT+SHIFT+3 to dial a pound and
ALT+SHIFT+8 to dial an asterisk.
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You can program station information and DND and Reminder messages for individual
stations in the Database Programming option in the Tools drop-down menu.

NOTE: Only Administrators can access the Database Programming option. The option
will be grayed out on the menu for all other user.

To begin programming: 
  1. Select Database Programming from the Console drop-down menu. The fol-

lowing screen appears: 

  2. Click Yes to continue. You are then prompted to enter
the database programming password, as shown in the
screen on the right. Enter the password (up to eight dig-
its) and click OK. (If there is no password, simply click
OK.)

  3. After you enter a valid password, the Attendant Console will retrieve data from
the system. When the data transfer is complete, you will see the following screen.
From this screen you can perform any of the programming procedures described
in the following pages. 
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Entry to the database programming feature at the Administrator stations can be pro-
tected using a password. A password would prevent unauthorized users from altering
the system database.

NOTE: Passwords are very important to system security. Without sufficient password
protection, the System database is vulnerable to unauthorized access.

To change the password: 
� Select Change Password from the Programmer drop-down menu in the Sys-

tem Programmer dialog. The following screen appears: 

Enter the current password, if any, in the Old Password text box. Then enter the
new password twice: once in the New Password text box and once in the Confirm
New Password text box. These two entries must match exactly. If they do not you
will see an error message and the password will remain unchanged. The password
may contain up to eight digits and include only numbers (0-9).

NOTE: You can also use your Administrator station to program a database pass-
word by entering the Program Database feature code (9932). For more details,
refer to the telephone system's Installation and Field Maintenance Manual or Adm-
nistrator's Guide.
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To enter information:
� While programming, you can double-click on any item in the list to change that

item. You can also use the following keyboard shortcuts to edit items without
using a mouse: 

As you move from one cell to the next, the new cell becomes a text box. You can
edit the selected item, or move to another field. 

To sort and move columns:
� Station information can be sorted in ascending order by column by simply select-

ing on that column�s header. You may also rearrange the columns by simply drag-
ging column headers to the desired position. 

To search: 
� You can search for a specific station by simply typing in text. The Attendant Con-

sole Programmer attempts to match characters with the data in the �Description�
column and numeric characters with the data in the �Extension� column. It then
selects the station with the best match. For example, if the following descriptions
and extensions are in the list:

If you type Smith, Ja it will find �Smith, Jack.� You could continue typing to
select the station with description �Smith, Jamie� or you could begin editing the
highlighted station.

KEYS DESCRIPTIONS
ESC Cancels the current change.
ENTER Applies the current change.
TAB Applies the current change and moves one cell to the right. If 

you are in the last column, it moves to the first cell of the next 
row. 

SHIFT+TAB Applies the current change and moves one cell to the left. If 
you are in the first column, it moves to the last cell of the pre-
vious row.

UP ARROW Applies the current change and moves one cell up.
DOWN ARROW Applies the current change and moves one cell down.
HOME Applies the current change and moves to the top cell in a col-

umn.
END Applies the current change and moves to the bottom cell in a 

column.
SPACE Toggles the administrator status of a station when the focus is 

in the Administrator column.

Smith, Jack 1308
Smith, James 1300
Smith, Jamie 1315
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If you type �130� it will find and select the station with extension �1300�. You
could continue typing to select the station with extension �1308� or you could
start editing the currently selected station.

• Descriptions and Usernames: You can program or change the description and/
or username for any station.
1. Scroll through the extension number list to locate the station you want to

program.
2. Highlight the station you wish to program and double-click on the Descrip-

tion or Username field. A text box appears in the field.
3. Enter new information or edit the existing information. Then press ENTER

to save your change. (To close the text box without changing the informa-
tion, press ESC.)

• Extension Numbers: The extension number for any station can be changed by
an Administrator. The new extension number cannot conflict with an existing
number.
1. Scroll through the extension number list to locate the station you want to

program.
2. Highlight the station you wish to program and double-click on the Exten-

sion field. A text box appears in the field.
3. Enter new extension number and press ENTER to save your change. (To

close the text box without changing the extension, press ESC.)
If you enter a conflicting extension number, you will see an error message that
tells you the extension already exists. To clear the error message click OK. The
extension returns to its previous setting and you can enter a new number.

• Attendant Stations: You can change the assigned Attendant for each station.
1. Scroll through the extension number list to locate the station you want to

program.
2. Highlight the station you wish to program and double-click on the Atten-

dant field. A text box appears in the field.
3. Enter the extension number of the station you wish to serve as the attendant

for this station. Then press ENTER to save your change. (To close the text
box without changing the attendant extension, press ESC.)
If the extension number you entered does not belong to an attendant station,
you will see an error message that tells you that it is an invalid extension. To
clear the error message click OK. The attendant extension returns to its pre-
vious setting and you can enter a new number.
Inter-Tel Attendant Console User Guide
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 • Administrator Stations: You can program a keyset station to be an Administra-
tor station, or you can remove its Administrator status. (You cannot program this
for your own station or a single-line station.)
1. Scroll through the extension number list to locate the station you want to

program.
2. Highlight the station you wish to program and double-click on the check box

in the Administrator field. 
3. Enter the extension number of the station you wish to serve as the attendant

for this station. 
If you attempt to change the Administrator flag for your own station or for a
single-line station, you will see an error message.

• Swap: This feature allows you to exchange (swap) the locations of two stations
on the same node. This is used when a station is physically relocated within the
same node and you want to update the database programming.

NOTE: The Swap feature is available on nodes that are running OAI protocol ver-
sion 6.1 or higher.

1. Highlight the station you would like to swap with in the Station tab, shown
below, and click Swap. The screen, shown on the next page, appears.
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2. The dialog contains only the devices that the Console can swap with (i.e.,
you cannot swap a keyset with a single line).

3. Highlight the station you would like to swap with and click OK.
Inter-Tel Attendant Console User Guide
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 • Toll Restrictions: You can determine the toll restriction classes of service
assigned to each station.
1. Scroll through the extension number list to locate the station you want to

program.
2. Click Toll Restrictions to view the following screen.

3. Determine whether you are programming toll restrictions for day or night
mode by selecting the Day or Night option button.
� Move the desired toll restrictions from the Exclude Toll Restriction list

to the Include Toll Restriction list, as follows:

• Highlight a toll restriction in the Exclude list and click Add-> to
move it to the Include list.

• Highlight a toll restriction in the Include list and click <-Remove
to move it to the Exclude list.

• Click Add All-> to move all restrictions to the Include list.

• Click <-Remove All to move all restrictions to the Exclude list.

4. When the Include Toll Restrictions list is correct, click OK to save your
changes and exit. (Or to exit without saving changes, click Cancel.)
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To Program Do-Not-Disturb and Reminder Messages:
� In the DND/Reminder tab you can delete or change the texts for the Do-Not-Dis-

turb and Reminder messages. The new messages can be any value (up to 16 char-
acters). 

When the system has a programmed Primary and Secondary Language, the sys-
tem has default messages in both languages. (Available languages are American
English, British English, Spanish, and Japanese.) 

NOTE: The Attendant Console can be used to program only the Primary Lan-
guage messages. To enter Japanese characters, you must use your keyset.

The default Do-Not-Disturb and Reminder messages are shown in the Program
Planning Sheet on pages 107 and 108.
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To change a message:

NOTE: Each node has its own list of DND or Reminder messages that can be used
only on that node. Changing messages in the Console Database Programming will
override any existing messages in a network. 

  1. Highlight the desired message, as shown above, and click Edit DND or Edit
Reminder below the list. The following screen appears:

  2. Enter the new message in the text box. Click OK to save your changes and exit to
the previous screen. (Or click Cancel to exit without saving changes.)
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ADMINISTRATOR DATABASE PROGRAMMING PLANNING 
SHEETS
ADMINISTRATOR DATABASE PROGRAMMING PASSWORD: 
___________________________

STATION PROGRAMMING: For each station to be programmed, record the following infor-
mation:

CHANGING STATION EXTENSION NUMBERS:

Description:
Username:
Extension Number:
This station's attendant:
Administrator station? Yes or No
Toll restriction classes of service:

OLD EXTENSION NUMBER NEW EXTENSION NUMBER
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DO-NOT-DISTURB MESSAGES:

DEFAULT MESSAGE NEW PRIMARY LANG. 
MESSAGE

NEW SECONDARY LANG. 
MESSAGE

MESSAGE 01 (DO-NOT-DISTURB)
MESSAGE 02 (LEAVE A MESSAGE)
MESSAGE 03 (IN MEETING UNTIL)
MESSAGE 04 (IN MEETING)
MESSAGE 05 (ON VACATION 'TIL)
MESSAGE 06 (ON VACATION)
MESSAGE 07 (CALL ME AT)
MESSAGE 08 (AT THE DOCTOR)
MESSAGE 09 (ON A TRIP)
MESSAGE 10 (ON BREAK)
MESSAGE 11 (OUT OF TOWN 'TIL)
MESSAGE 12 (OUT OF OFFICE)
MESSAGE 13 (OUT UNTIL)
MESSAGE 14 (WITH A CLIENT)
MESSAGE 15 (WITH A GUEST)
MESSAGE 16 (UNAVAILABLE)
MESSAGE 17 (IN CONFERENCE)
MESSAGE 18 (AWAY FROM DESK)
MESSAGE 19 (GONE HOME)
MESSAGE 20 (OUT TO LUNCH)
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REMINDER MESSAGES:

DEFAULT MESSAGE NEW PRIMARY LANG. 
MESSAGE

NEW SECONDARY LANG. 
MESSAGE

MESSAGE 01 (MEETING):

MESSAGE 02 (STAFF MEETING):

MESSAGE 03 (SALES MEETING):

MESSAGE 04 (CANCEL MEETING):

MESSAGE 05 (APPOINTMENT):

MESSAGE 06 (PLACE CALL):

MESSAGE 07 (CALL CLIENT):

MESSAGE 08 (CALL CUSTOMER):

MESSAGE 09 (CALL HOME):

MESSAGE 10 (CALL CORPORATE):

MESSAGE 11 (CALL ENGINEERING):

MESSAGE 12 (CALL MARKETING):

MESSAGE 13 (CALL ACCOUNTING):

MESSAGE 14 (CANCEL DND):

MESSAGE 15 (CANCEL CALL FWD):

MESSAGE 16 (TAKE MEDICATION):

MESSAGE 17 (MAKE RESERVATION):

MESSAGE 18 (REVIEW SCHEDULE):

MESSAGE 19 (LUNCH):

MESSAGE 20 (REMINDER):
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Troubleshooting
Inter-Tel Atten
This chapter contains troubleshooting information for the Attendant Console. It
includes a discussion of error messages and answers to commonly asked questions
about Attendant Console operation.
If you cannot locate the troubleshooting information you need in this chapter, call
your Inter-Tel dealer for additional assistance.
The error message information includes:
• Troubleshooting OAI Connections (see below)
• Troubleshooting the Installation (see page 112)
• Error Messages (see page 113)
• Frequently Asked Questions (see page 122)
TROUBLESHOOTING OAI CONNECTIONS
These are the steps you should follow when troubleshooting System OAI. For best
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results, perform the steps in order, one at a time. Never change more than one variable
at a time when troubleshooting hardware. 
 • Verify that you can see system call activity. This is the easiest way to determine

that System OAI is being received by the Console.
 • Verify that System OAI Events and System OAI Third Party Call Control Pre-

mium Features are enabled on all nodes.
 • Verify that you have configured the Console TCP/IP connection to the telephone

system correctly. For TCP/IP to work on your computer, it must be configured
with IP addresses, subnet masks, and a default gateway for each network adapter
on the computer. To determine if TCP/IP is installed on your computer, check
with your Network Administrator.

Refer to the telephone system's Installation and Field Maintenance Manual for more
information on the System features.
The following are answers to commonly asked questions about OAI Configuration. 
TIN
FREQUENTLY ASKED QUESTIONS ABOUT OAI CONFIGURATION
G
Q: WHAT DO I NEED TO MAKE THE ATTENDANT CONSOLE WORK ON A SINGLE-NODE?
A: The Console requires System Level II OAI in a TCP/IP protocol. This will

require a Call Processing (CP) Server (previously called Windows NT-based
CPU), a Switch Transceiver, or an Axel AX4010 Office Server. The CP Server
automatically delivers the OAI stream in a TCP/IP format, which the Console
understands. The Switch Transceiver converts the OAI stream from an RS232
format into a TCP/IP format using a physical PC COM Port. The Axel Office
Server converts the OAI stream from an RS232 format into a TCP/IP format,
which the Console understands.
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Q: CAN I USE MORE THAN ONE CONSOLE ON A NODE?

A: As stated above, each Console application requires its own connection to an OAI
Server (CP Server or Switch Transceiver, as described above), because there are
limitations to the number of System Level II OAI applications. For example, one
Console can communicate with one Switch Transceiver (OAI Server). In other
words, one Console can be serviced by one serial port. There is a ratio of 1:1
when dealing with a Switch Transceiver. If you have two Consoles, you will need
two RS232 connections on the CPU connected to two serial ports on a PC run-
ning the Switch Transceiver. This becomes very cluttered and uses valuable
RS232 ports on the CPU. The CP Server offers a ration of 1:30, meaning 30 Con-
soles (or equivalent OAI applications) can be serviced by one CP Server. The
final solution is the new Multi-Application CT Gateway. This software allows for
an infinite number of applications to connect to a single CT Gateway and only
requires a single RS232 connection to the switch. A single Switch Transceiver or
CP Server is stilled required to send the OAI stream in a TCP/IP format.

Q: WHEN DO I NEED THE CT GATEWAY?
A: The CT Gateway is required in the following environments. Please consult the

OAI Configurator or Sales Engineering for more specifics.
 • Network environment with System Level II OAI applications 
 • A non-CP Server single node 
 • Several System Level II OAI applications

Q: DO I NEED THE SWITCH TRANSCEIVER OR CP SERVER ON EVERY NODE IN A
NETWORK ENVIRONMENT?

A: Yes. In order for the Console or any System Level II OAI application to receive
information from a node, the OAI stream must be sent in a TCP/IP format across
the LAN/WAN. Note that the CP Server requires the CT Gateway to unify the
OAI streams from multiple nodes.

Q: WHAT APPLICATIONS CAN RESIDE ON THE SAME PC? CAN I PUT THE CT
GATEWAY ON A CP SERVER?

A: The CP Server should never house any other software (i.e., CT Gateway, Voice
Mail, etc.). You may however, load the CT Gateway and Switch Transceiver soft-
ware on the same PC. Minimum specifications are:
 • CP Server: Please consult with Sales Engineering for Approved PC List
 • Switch Transceiver: Win 98/Me/NT/2000, Pentium II, 300MHz or higher,

64 MB RAM, CD-ROM, NIC, etc. (Highly recommend Windows NT/2000
over Windows 98 also highly recommend a Control RocketPort card, see the
Switch Transceiver installation manual for details)

 • CT Gateway: Windows NT/2000, Pentium III, 400 MHz or higher, 128 MB
RAM, CD-ROM, NIC, etc. (Windows NT/2000 only)
Inter-Tel Attendant Console User Guide
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 • Attendant Console: Windows 98/Me/NT/2000/XP, Pentium II, 200 MHz or
higher, 32 MB RAM, CD-ROM, NIC, etc.

Q: HOW MANY PAL UNITS DO I NEED FOR THE CONSOLE? WHY?
A: The Attendant Console connected to Inter-Tel telephone system(s) and all of the

nodes connected to a CP Gateway require the System OAI Events and System
OAI Third Party Call Control PAL Feature Units enabled (total 60 units for ver-
sions 5.3 and lower and 30 units for versions 6.0 and higher). By using System
Level OAI, the application becomes much more interactive. The Attendant may
now have access to all of Inter-Tel�s features and the power to change stations
Active/Busy state, view multiple nodes, perform basic database programming
actions, create unlimited key maps, etc.

Q: DO I NEED TO MATCH THE MAIN NODE'S PAL UNITS ON A REMOTE NODE?
A: Yes. Each node that it being used by the Transceivers\CP Server must have the 60

Feature Units (System OAI level II enabled).
Q: DO I NEED MULTIPLE CT GATEWAYS TO CONNECT TO MULTIPLE CTI APPLICA-

TIONS?
A: No. The Multi-App CT Gateway is able to communicate with an infinite number

of CTI applications.
Q: WHAT IS AN APPLICATION TRANSCEIVER? WHEN DO I NEED IT?
A: An Application Transceiver is software that converts the OAI stream from a

TCP/IP format to RS232. The Application Transceiver is used only with pro-
grams that can communicate only via RS232. The Attendant Console communi-
cates via TCP/IP, so you never need an Application Transceiver to run the
Attendant Console.
111dant Console User Guide
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TROUBLESHOOTING THE INSTALLATION
112
During the installation, you may see one of the following Warning or Error Messages:
ERROR OR 
WARNING PROBLEM FIX

File In Use 
Warning

The file exists on your PC and is in
use. 

Close all other applications before
continuing the installation. Select
OK to continue. 

EXE File In Use Error An earlier installation of Attendant
Console software is currently in use. 

Select OK and close the earlier
version. Restart the installation.

Destination File Error:
cannot create direc-
tory or file

This is usually caused by a write-pro-
tection conflict on a network drive or
by a shortage of available space. 

The text of the warning will give
you the information needed to fix
the problem. 
These are the steps you should follow when troubleshooting System OAI. For best
results, perform the steps in order, one at a time. Never change more than one variable
at a time when troubleshooting hardware. 
• The Inter-Tel telephone system must be using version 5.1 or higher software on

all nodes (5.119 or higher recommended).
• Verify that you can see system call activity. This is the easiest way to determine

that System OAI is being received by the Attendant Console.
• Verify that System OAI Events and System OAI Third Party Commands Pre-

mium Features are enabled on all nodes.
• Verify that you have configured the Attendant Console TCP/IP connection to the

telephone system correctly. For TCP/IP to work on your computer, it must be
configured with IP addresses, subnet masks, and a default gateway for each net-
work adapter on the computer. To determine if TCP/ IP is installed on your com-
puter, check with your Network Administrator.

Refer to the telephone system Installation and Field Maintenance Manual for more
information on the Telephone System features.
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ERROR MESSAGES
CONNECTION ERRORS
The Attendant Console connects to the telephone system via a System OAI Server.
When the attempt to connect fails, the system provides short error messages in the
start-up window. The Attendant Console will automatically retry the connection every
15 seconds. You can override this default by selecting the Retry Now button from the
start-up window. The help button will give more detailed information for each error
message.
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ERROR POSSIBLE PROBLEM FIX
Cannot Assign
Requested
Address

Attendant Console cannot con-
nect to the specified IP
address. 

Verify the IP address is the IP address of the
OAI Server computer. To do so, select Options
from the Console drop-down menu. On the Con-
nection tab, select the OAI Server and click
Edit. If the OAI Server is the CT Gateway, the IP
address must match the IP address in the CT
Gateway Application Settings dialog.
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Connection
Refused

Wrong TCP port Verify the TCP port. To do so, select Options
from the Console drop-down menu. On the Con-
nection tab, select the OAI Server and click
Edit. The TCP port must be the same as the
OAI Server TCP Port. The default TCP Port of
an OAI Server is 4000. The System OAI Switch
Transceiver and the CT Gateway provide con-
figuration screens to change the port. If the
default has been changed, you must refer to the
Transceiver or Gateway to determine the cor-
rect TCP Port.
If connecting to an Axel Office Server, you can
set the TCP port via telnet. Telnet to the Axel's
IP address at TCP port 4096 (type �telnet
<axel_ip_addr> 4096" at a command prompt).
TCP port 4096 is the configuration port. Once
connected to the Axel Office Server, you can
change the configured TCP port by selecting
Network Service under Serial Line Setup.

Wrong IP address Verify the IP address of the OAI Server. To do
so, select Options from the Console drop-down
menu. On the Connection tab, select the OAI
Server and click Edit. The IP Address must be
the address of the computer running the OAI
Server. The OAI Server can be the CT Gateway,
System OAI Switch Transceiver, CP Server, or
Axel Office Server.

CT Gateway or OAI Server not
ready

Verify the OAI Server is running, that it is com-
municating with all nodes, and that it has at
least one node programmed.
The CT Gateway will not allow Attendant Con-
sole to connect until the CT Gateway is commu-
nicating with all nodes.
If a CT Gateway is communicating with all
nodes and the IP address and TCP port are cor-
rect, restart the CT Gateway computer. 
Verify the CT Gateway starts and communicates
with all nodes. If the problem continues, try
restarting the Attendant Console computer.

ERROR POSSIBLE PROBLEM FIX
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Waiting for
response from
telephone sys-
tem

Axel Office Server unable to
communicate with telephone
system

Verify the hardware cables between the Axel
Office Server and the telephone system are
properly attached.

Verify the system is using the proper serial
cable (part number 813.1682) and modular
adapter (part number 804.2545). These parts
are available in the System OAI PC Connection
Kit (part number 828.1427) or the Universal
RS232 Kit (part number 828.1282).

Verify the Axel Office Server is configured with
the same baud rate as the telephone system
serial port.

Verify the telephone system serial port is config-
ured for Level 2 System OAI.

Verify the telephone system serial port is config-
ured for hardware flow control and auto baud is
disabled.

CT Server, Switch Transceiver,
or Call Processing Server not
responding

Restart the server.

The server
closed the con-
nection

Axel Office Server is already in
use by another application

Only one application can use a serial port. Verify
the console is connecting to the correct TCP
port. To do so, select Options from the Console
drop-down menu. The Connection tab shows
the TCP port.
If the TCP port is correct, determine what IP
address is already using the Axel Office Server.
To do this, telnet to the Axel Office Server's con-
figuration port: �telnet <axel_ip_addr> 4096".
Select Connections from the Tools Setup
menu.

ERROR POSSIBLE PROBLEM FIX
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CT Server, Switch Transceiver,
or Call Processing Server not
responding

Verify the Attendant Console is using the correct
OAI password. To do so, select Options from
the Console drop-down menu. On the Connec-
tion tab, select the OAI Server and click Edit.
This password must match the password
required by the OAI Server.

NOTE: This password is case sensitive.

Connection
Reset by Peer

The connection was reset
either by the network system or
the OAI Server computer.

Verify the OAI Server is running. If the problem
persists, contact your Network Administrator,
and see the suggestions in the section titled,
�Software Caused Connection Abort.� on
page 119.

Connection
Timed Out

Attendant Console could not
initiate a connection to the OAI
Server because the OAI Server
computer never responded.

Verify if the IP address of the OAI Server is cor-
rect. To do so, select Options from the Console
drop-down menu. On the Connection tab, select
the OAI Server and click Edit. If the OAI Server
is a CT Gateway, the IP address must match the
IP address in the CT Gateway Application Set-
tings dialog. 
Check the Attendant Console computer subnet
mask. An improper subnet mask can cause this
error. If you do not know your subnet mask, con-
tact your Network Administrator.
Contact your Network Administrator to verify all
routers are up and running (check by pinging
them, and then ping addresses on the other
side of them). Try a trace route to the destina-
tion address to check that all routers are func-
tioning.

Incorrect node
number (node
#) or extension
(ext #)

The station password could not
be verified.

Verify your node and extension are correct. To
do so, select Options from the Console drop-
down menu. On the Connection tab, verify the
Attendant Station node and extension match the
node and extension of your telephone. If your
telephone has a display, you can determine the
correct node by resetting your telephone.

ERROR POSSIBLE PROBLEM FIX
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Destination
Address
Required

The Attendant Console cannot
connect to the OAI Server IP
Address.

Verify the IP address of the OAI Server com-
puter. To do so, select Options from the Con-
sole drop-down menu. On the Connection tab,
select the OAI Server and click Edit. If the OAI
Server is the CT Gateway, the IP address must
match the IP address in the CT Gateway Appli-
cation Settings dialog.

Invalid Station 
Password

The keyset password is incor-
rect

Select Options from the Console drop-down
menu and then click Connection tab. Verify that
the node and extension are correct. If the node
and extension are correct, the station password
is incorrect. Enter the correct station password
on the Connection tab (see page 21).

Invalid OAI 
Password

The OAI Password is incorrect. Set the correct OAI password. To do so, select
Options from the Console drop-down menu. On
the Connection tab, select the OAI Server and
click Edit. This password must match the pass-
word required by the OAI Server. 

NOTE: This password is case sensitive. 

Network
Dropped Con-
nection

The OAI Server computer
might have crashed and/or
rebooted.

If the problem persists and the OAI Server is not
rebooting, contact your Network Administrator,
and see the suggestions under �Software
Caused Connection Abort� on page 119.

Network is
Down

This error could indicate a fail-
ure of your network subsystem.

Check the Attendant Console computer Wins-
Sock, protocol stack, network driver, and net-
work interface card configuration. Restart the
computer. If the problem persists, you may need
to reinstall TCP/IP.

ERROR POSSIBLE PROBLEM FIX
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Network is 
Unreachable

This occurs if Attendant Con-
sole cannot communicate with
the OAI Server computer.

Verify the OAI Server IP address. To do so,
select Options from the Console drop-down
menu. On the Connection tab, select the OAI
Server and click Edit. 
If the OAI Server computer is running and the
Attendant Console knows the correct IP
address, contact your Network Administrator.
You might try the following:
• Ping the destination host to see if you get 

the same results (chances are, you will).
• Check whether you have a router config-

ured in your network system (your Win-
Sock implementation).

• Do a traceroute to try to determine where 
the failure occurs along the route between 
your host and the destination host.

Network Sub-
system is Not
Initialized

See �Network Subsystem is
Unavailable�.

Network Sub-
system is
Unavailable

Windows cannot fulfill commu-
nication requirements of Atten-
dant Console because the
underlying system is currently
unavailable

Verify that networking and TCP/IP is correctly
and fully installed on the Attendant Console
computer. You might need to reinstall network-
ing, TCP/IP, or Windows to correct this problem.

No Buffer
Space Avail-
able

This indicates a shortage of
resources

This can occur if you are running too many
applications simultaneously. If this tends to
occur after running certain applications, it may
be a symptom of a malfunctioning application.
This error can also indicate that you are not
closing applications properly. If the error per-
sists, restart the Attendant Console computer.
Avoid running the offending application.

No Route to
Host

See �Network is Unreachable�

Ports
Exceeded

The Attendant Console is
unable to connect to the OAI
Server at this time because the
server is already communicat-
ing with the maximum number
of client applications.

ERROR POSSIBLE PROBLEM FIX
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Software
Caused Con-
nection Abort

This is usually a network error. Try the software again. If the software is still not
working, contact your Network Administrator.
Ping the remote OAI Server. If it does not
respond, it may be offline or there may be a net-
work problem. If it does respond, then try recon-
necting. If the Attendant Console still doesn�t
work, the OAI Server may have terminated.Ping
the router address. If using a serial connection,
the local router is the IP address of the host you
initially logged into with SLIP or PPP.Ping a local
host to verify that the local network is working
properly.
Ping a host connected to the same subnet as
the host you were using. This will verify if the
destination network is functioning.
Do a traceroute to try to determine where the
failure occurs along the route between your host
and the destination host.

Too Many
Open Files

Windows cannot fulfill Atten-
dant Console TCP/IP commu-
nication requirements. This
error occurs due to one of two
scenarios:
The computer is running too
many programs that communi-
cate via the network.

Close some of the programs.

A program running on the com-
puter is using the network facili-
ties incorrectly and holding
resources required by the
Attendant Console.

Restarting the computer may temporarily solve
this problem. However, if the program malfunc-
tions again, Attendant Console will have the
same problem. Use trial and error to determine
which application is interfering, and close it
when Attendant Console is in use.

Wrong Login
Type

The OAI Server does not serve
System OAI. It may be a Desk-
top OAI Server.

Enter the correct address and port of the Sys-
tem OAI Server (CP Server, OAI Gateway, or
Switch Transceiver). To do so, select Options
from the Console drop-down menu. On the Con-
nection tab, select the OAI Server and click
Edit.

Wrong Win-
Sock DLL Ver-
sion

Windows does not support the
TCP/IP version required by
Attendant Console.

Reinstall TCP/IP. If the problem persists, check
to see if Microsoft has an update or patch to
resolve the version conflict.

TCP Protocol
Not Installed

Install the TCP Protocol from the Windows Net-
work Control Panel.

ERROR POSSIBLE PROBLEM FIX
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Cannot Com-
municate with
Telephone Sys-
tem Node

Incorrect node number setting Select Options from the Console drop-down
menu. On the Connection tab, verify the Atten-
dant Station node matches the node of your
telephone. If your telephone has a LCD display,
you can determine the correct node by resetting
your telephone.

System OAI Switch Trans-
ceiver -- RS232 connection not
operating properly.

Troubleshoot the connection following the
instructions provided with the transceiver.

Telephone system serial port
not programmed
Telephone system failure

Tell them how to program the telephone system
serial port in Database Programming.

System OAI Server is a CT
Gateway, perhaps the Gateway
is unable to communicate with
the node due to a network
error.

Refer to the CT Gateway help and user guide to
determine how to correct the problem.

The OAI Server does not serve
the correct node.

If the OAI Server is a Switch Transceiver or CP
Server and the Attendant Station node number
is correct, the Attendant Console must connect
to a different OAI Server. The OAI Server must
serve the user's telephone-system node.
If the OAI Server is the CT Gateway, ensure the
Gateway is configured to communicate with the
user's telephone-system node.

Socket Dis-
abled Error

The telephone system is con-
figured to reject System OAI
Level 2 connections via TCP/
IP.

Your telephone System Administrator must
enable System OAI Level 2 sockets.
To enable System OAI Level 2: 
• Select System - Premium Features in the 

System Database Programming. 
• Change the System OAI Third Party Call 

Control 's value to Yes. Note that it 
requires 30 feature units.

• Select System - Cabinets - CPU - Sock-
ets in the System Database Programming.

• Change the System OAI Level 2's value to 
Yes.

The OAI Server
is unable to
communicate
with the tele-
phone system

Axel Office Server incorrectly
connected to the telephone
system

Ensure the Axel Office Server is connected to
the telephone system using a DB9 modular
adapter (part no. 804.2545) and a reversing 8-
wire mod-to-mod line cord (part no. 813.1682).

ERROR POSSIBLE PROBLEM FIX
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Axel Office Server's bit rate is
configured incorrectly 

The bit rate configured in the Axel Office Server
must match the bit rate of the telephone system
CPU serial port.  Ensure these bit rates match.
Also, ensure Autobaud is disabled on the tele-
phone system serial port.

Wrong TCP port The Axel Office Server provides four serial
ports.  Ensure the Attendant Console TCP port
matches the serial port that is connected to the
telephone system.

Telephone System serial port
not programmed 

Ensure the telephone system serial port is con-
figured for System OAI level 2 (no EFP) and
both System OAI Events and System OAI Third
Party Call Control premium features are
enabled.

The OAI Server
unexpectedly
closed the con-
nection

Axel Office Server is already in
use by another application 

Only one application can use a serial port. Verify
the console is connecting to the correct TCP
port To do so, select Options from the Console
drop-down menu. The Connection tab shows
the TCP port.If the TCP port is correct, deter-
mine what IP address is already using the Axel
Office Server. To do this, telnet to the Axel
Office Server's configuration port: "telnet
<axel_ip_addr> 4096". Select Connections
from the Tools Setup menu.

CT Server, Switch Transceiver,
or Call Processing Server not
responding 

Verify the Attendant Console is using the correct
OAI password. To do so, select Options from
the Console drop-down menu. On the Connec-
tion tab, select the OAI Server and click Edit.
This password must match the password
required by the OAI Server.

NOTE: This password is case sensitive.

ERROR POSSIBLE PROBLEM FIX
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FREQUENTLY ASKED QUESTIONS 
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Following are answers to commonly asked questions about Attendant Console opera-
tion. They are divided into general topics to help you locate the information quickly.
If you cannot locate the answer to your question in the following list, call your Atten-
dant Console dealer for assistance.
ATTENDANT CONSOLE SETUP OPTIONS

Q: HOW CAN I GET MY ATTENDANT CONSOLE SCREEN TO POP UP FROM AN ICON WHEN I

RECEIVE A CALL OR MESSAGE?
A: Enable �Restore Program When Call Rings� from the User tab on the Options

dialog.
SCREEN WILL NOT POP-UP

Q: EVEN THOUGH I SET RESTORE PROGRAM WHEN CALL RINGS IN, WHY DOESN�T THE

ATTENDANT CONSOLE COME TO THE FRONT WHEN A CALL RINGS IN?
 A: Microsoft added a feature to Windows 98, Windows 2000, and Windows Millen-

nium Edition to prevent an application from popping in front of the application
you're currently using. If another application has received input from the user
within a short, but undocumented, amount of time, Windows 98 prevents any
other program from putting itself in the foreground. Instead, the program can
only flash it's icon in the start bar.
Therefore, if you are using another program, like Word, and a call rings in, Win-
dows 98 may prevent the Attendant Console from popping in front of Word, but
will instead force the Attendant Console to blink in the task bar.

Q: WHY DON'T THE FUNCTION KEYS WORK LIKE THEY'RE DESCRIBED IN THE USER
GUIDE?

A: The function keys are programmable. Yours may have been reprogrammed to
new settings. See page 33.
DIRECTORIES

Q: WHY IS THE NAME IN THE ATTENDANT CONSOLE DIRECTORY DIFFERENT FROM THE

NAME SHOWN IN THE TELEPHONE INTERCOM DIRECTORY AND ON MY PHONE DIS-
PLAY?

A: The telephone system Intercom Directory and phone display identifies intercom
numbers using their programmed usernames, while the Attendant Console direc-
tory uses their programmed description. The description reflects the directory
name format of the telephone system database (Last, First). 
MUTING YOUR PHONE MICROPHONE

Q: WHEN ANOTHER STATION USER PLACES ME ON HOLD, WHY WON'T THE MICROPHONE
Inter-Tel Attendant Console User Guide
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MUTE WORK?
A: You cannot mute the microphone on your phone if you are connected with

another station and the other party places you on hold.
VOLUME

Q: I SET MY PHONE VOLUME, BUT IT KEEPS CHANGING. WHY?
A: There are separate volume levels for the different functions of your phone

(handsfree calls, handset calls, etc.). Changing one volume setting will not
change the other settings.
CONFERENCE CALLS
TR
O

U
B

LESH
Q: WHY CAN'T I INCLUDE A VOICE PROCESSING UNIT IN A CONFERENCE?
A: A Voice Processing Unit application is not a valid conference party. However, a

conference can be transferred to a Voice Mail application to allow the conference
parties to use the Voice Mail features. When you transfer the conference to voice
mail, the system waits for you to enter the mailbox number. If you do not enter a
mailbox number before you hang up, the conference will be connected to the
voice mail unit and a conference party must enter the mailbox number after lis-
tening to the introductory voice prompts. The conference parties can use their
DTMF keypad keys to use the voice mail features. 
A conference conversation could be recorded as a mailbox message using this
technique.

Voice Processing Units can also be programmed to use Record-a-Call. For more
information, refer to your Voice Processing Unit guide.

NOTE: Federal and State law may prohibit the use of this feature to record in cer-
tain circumstances. Inter-Tel does not give any legal advice on this subject. Contact
your attorney for guidance on the use of this feature.
O
O

T

DIALING A FEATURE CODE OR DIGITS WHILE ON A CALL
IN
G

Q: HOW DO I DIAL DIGITS WHILE I AM ON A CALL?
A: You can dial digit(s) using the ALT (alternate) key. See page 95 for more details

on how to dial digit(s) or a feature code.
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TIME DIFFERENCES
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Q: WHY DOESN'T THE TIME ON MY COMPUTER MATCH THE TIME SHOWN ON MY PHONE?
A: The time shown on the computer display may not match the time shown on the

attached phone�s display because the PC clock controls the computer display and
the telephone system controls the phone display.

Q: I SET A REMINDER MESSAGE, BUT IT DID NOT SIGNAL ME EXACTLY AT THE TIME I
REQUESTED IT TO. WHY NOT?

A: Reminder messages are controlled by the clock in the telephone system, not the
clock on your PC. If the time shown on your PC does not match the time shown
on your phone's display, it may appear that the reminder message is signaling you
at the wrong time. However, it is actually signaling at the time you requested �
according to the telephone system clock (shown on your phone).

Q: WHY DOESN'T THE ATTENDANT CONSOLE�S ELAPSED CALL TIME MATCH THE TELE-
PHONE SYSTEM�S ELAPSED CALL TIME?

A: The telephone system�s elapsed call time starts when the call is picked up by the
phone system. The Attendant Console�s elapsed call time starts when the call
reaches your phone.

NOTE: In System version 5.3 or higher, the elapsed time will match.
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MAILBOX SETTINGS
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Q: WHY IS THE �HAS MAILBOX� OPTION IN THE DIRECTORY ENTRY PROPERTIES DIA-
LOG UNAVAILABLE (GRAYED OUT)?

A: �Has Mailbox� is available only when a station or hunt group is selected. Also, if
you are running telephone system version 5.2 or higher software, this option is
never available, because the Attendant Console receives the mailbox information
directly from the Telephone System.

NOTE: The �Has Mailbox� option is available when the system is version 5.1 or if
the �Get Mailbox information from telephone system� check box under the Program
tab of the Options dialog is not checked.

Q: HOW CAN I CORRECT INVALID MAILBOX INFORMATION IF WE ARE RUNNING TELE-
PHONE SYSTEM VERSION 5.2 OR HIGHER SOFTWARE?

A: If the Attendant Console has the wrong mailbox information, try performing a
system refresh. If it is still incorrect, contact the System technician ask to have
the mailbox information imported from the other nodes to your node and/or have
the mailboxes reprogrammed.
STATISTICS
TR
O

Q: WHY DO MY STATISTICS SHOW MORE CALLS HANDLED THAN CALLS RANG IN?
A: This is because �handled� calls count calls originated by the user. Every time an

IC or CO call leaves the operator, it was handled, unless it was on hold, was ring-
ing, or was a transfer announcement call. When a conference is made each call in
the conference is counted as handled and the conference call is treated as a new
call. Calls that automatically forward are not counted as handled.
U
B

DATABASE PROGRAMMING
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Q: I TRY TO ACCESS DATABASE PROGRAMMING, BUT IT TELLS ME THAT MY PHONE DATA-
BASE PROGRAMMING PASSWORD IS INVALID ON MY NODE. BUT I KNOW MY PASSWORD
IS CORRECT BECAUSE IT WORKS ON MY PHONE. WHY DOES MY PASSWORD CAUSE THIS
ERROR?

A: The phone allows you to program only one node. Therefore, it validates your
password only on that node. However, the Attendant Console allows you to pro-
gram multiple nodes and requires all nodes to have the same phone database pro-
gramming password.

Q: WHY IS DATABASE PROGRAMMING DISABLED (GRAYED OUT) ON MY ATTENDANT
CONSOLE?

A: If your phone is not programmed as an Administrator station, you cannot perform
database programming.
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Index
A

Action bar   31
Adding a call to the conference   92
Adjusting the volume   55
Administrator

features
night mode   1
setting time and date   1
system alarms   2

Administrator database programming planning sheets   106
Administrator stations   48,   101
Alarms

see also Major alarms and Minor alarms
Announced transfer   86
Answer button   83
Answering calls   83
Attendant Console   5
Attendant Console setup options   122
Attendant stations   100

B
Begin Conference button   3,   91,   92
Begin Page button   1
Building a conference   91

C
Call button   94
Call forwarding   106
Call Handling drop-down menu   34,   40
Call Handling menu

answer   83
conference   91
hang up   84
individual hold   90
message   93
system hold   90

Call List   31,   32,   83,   91
Call Log tab   31
Canceling a transfer   87,   89
Change font   39
Communications parameters   5
Conference   31,   78,   91,   92
Conference button   91
Conference call

adding a call   3
Conference Calls   91,   123

adding a call   92
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troubleshooting   123
Conference tab   3
Connected Call

conferencing   91,   92
Connected call

conferencing   3
Connecting a conference   3,   92
Connection   18
Connection errors   113
Connection tab   21
Console drop-down menu   34
Console main screen   31
Console menu   34

log on/off   9
Console users

logging on/off   9
removing   9

CT Gateway   5
CTRL key   56
Custom directory   81
Custom entry   50
Customize directory   73

D
Database programming   81,   109,   125
Date and time display

programming   1
Descriptions and user names   100
Desktop interface   4
Diagnostics   25
Diagnostics tab   25
Dial pad   73,   78
Dialing a feature code   95
Dialing a feature code or digits while on a call   123
Dialing digits   96
Directories   122
Directory

system refresh   10
troubleshooting   122

Directory drop-down menu   43
Directory List   44
Directory tab   31

Set DND button   48
Disconnecting calls   84
Display bar   31

troubleshooting   124
DND/Reminder tab   104
Do-not-disturb

messages   48
setting other stations   48

Download telephone system data   10
Drag and drop
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conference calls   91
Drop-down menus   31,   34

E
Entering Information   99
Error messages   113

software installation   112
Exit   39
Extension numbers   100

F
Feature codes   73,   79

system refresh   10
Features

access to   106
Features tab   31,   56

run button   56
Floppy disk drive   4
Forwarding

see call forwarding or system forwarding   106
Frequently asked questions   122
Frequently asked questions about OAI Configuration   109
Function keys   122

G
Getting started   3
Group lists   2
Group setup   76,   80

H
Handling calls   83
Handset   83
Handsfree speakerphone   83
Hang Up button   84
Hanging up   84
Hard disk space   4
Hardware requirements   4
Has mailbox   51
Headset   4,   83

connect tone   4
Help drop-down menu   82
Help menu   34
Hidden entries   73
Hide entry   49
Hold   90

individual   90
system   90

Holding calls   90
How to handle calls   83
128
I
Immediate transfer   85
Individual Hold button   90
Installing the Attendant Console Software   6
Intercom calls

messages   106
Inter-station messages   93,   106

L
Leaving a message   93
Locations   18
Locations tab   18
Log Off   34
Log On/Off   34
Logging Off   9
Logging On   8

M
Mailbox settings   125
Mailboxes

system administrator   2
Main Attendant Console screen   31
Main screen   31
Major alarms   2
Message button   93
Message center   93,   94
Message tab   31,   93,   94
Messages   65,   80,   93

cancelling   94
inter-station   106
leaving   93
number of   94
removing from list   94

Minor alarms   2
Monitor   4
MSG   65,   94
Multi-party conference   91
MUTE   65
Muting the microphone   55

troubleshooting   109,   122,   123,   125
Muting your phone microphone   122

N
Network

setting time   1
synchronizing clocks   1

NGT   2,   65
Night Mode   19,   38,   65

tab   19
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Night mode   2
network   1

O
Options   39

P
Page tab   1,   31
Page Zones   81

system refresh   10
Page zones   1
Parallel port   4
Part numbers   2
Performing a system refresh   10
Placing calls   83
Program Settings   16
Program Tab   16
Programming do-not-disturb and reminder messages   104
Programming station information   97
Properties

general
restore for incoming call   122

Putting calls on hold   90

R
RAM   4
Refresh   10
Related documentation   2
Responding to a message   94
Restore program when call rings

troubleshooting   122
Ringing calls   83
Run button   56

S
Screen pop   122
Screen will not pop-up   122
Searching   99
Set DND   48
Set DND button   48
Set forward   48
Setting Attendant Console properties   11
Setting night mode   2
Setting time and date

network   1
Setup shortcuts   58
Shortcut keys   31,   56

using   56
Shortcut Panels 1-4   68
Shortcuts drop-down menu   56
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Shortcuts menu   34,   56
Silent message   93
Software

installation
error messages   112

Software requirements   4
Software security key   5
Sorting and moving columns   99
Split between the announcement call and transfer party   88
Starting the Attendant Console application   8
Station description   122
Station off-hook alarm   2
Station tab   99
Station username   122
Statistics   76,   125
Status bar   2,   31,   65
System alarms   2
System Hold button   90
System night mode   2
System refresh   10,   39
System requirements   4

T
Tagging calls   84
TCP/IP connections   5
Telephone system   4

data   10
network   4

Time differences   124
Time display

network   1
Toll restrictions   103
Toolbars   63
Tools drop-down menu   69
Transfer tab   14
Transfer type   51
Transferring a call

with hot dialing   87
without hot dialing   88

Transferring calls   85
Transferring to voice mail   86
Troubleshooting   109,   127
Troubleshooting OAI connections   109
Troubleshooting the installation   112

U
Upgrading the Attendant Console software   7
User options   14
User settings   11
User tab   11
Using Attendant Console   29
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V
VGA   4
Video card   4
View drop-down menu   63
View menu   34

shortcut panels   56
Voice mail

group lists   2
mailbox maintenance   2
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Volume   123
Volume bar   31
Volume drop-down menu   55
Volume menu   34

W
Warnings tab   24
Welcome   1
Window tabs   31
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